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Safety Summary
The following general safety precautions must be observed during all phases of operation 
of this instrument. Failure to comply with these precautions or with specific warnings or 
operating instructions in the product manuals violates safety standards of design, 
manufacture, and intended use of the instrument. Keysight Technologies assumes no 
liability for the customer's failure to comply with these requirements. Product manuals 
are provided with your instrument on CD-ROM and/or in printed form. Printed manuals 
are an option for many products. Manuals may also be available on the Web. Go to 
www.keysight.com and type in your product number in the Search field at the top of the 
page. Safe operation and the general safety precautions for the M9502A and M9505A 
AXIe chassis, must be followed. See: http://www.keysight.com/find/M9505A.

Initial Inspection Inspect the shipping container for damage. If there is damage to the container or 
cushioning, keep them until you have checked the contents of the shipment for 
completeness and verified the instrument both mechanically and electrically. The 
Performance Tests give procedures for checking the operation of the instrument. If the 
contents are incomplete, mechanical damage or defect is apparent, or if an instrument 
does not pass the operator’s checks, notify the nearest Keysight Technologies 
Sales/Service Office.

WARNING To avoid hazardous electrical shock, do not perform electrical tests when 
there are signs of shipping damage to any portion of the outer enclosure (covers, panels, 
etc.).

General This product is a Safety Class 3 instrument (provided with a protective earth terminal). 
The protective features of this product may be impaired if it is used in a manner not 
specified in the operation instructions.

Laser Safety Information Class 1 Laser product according IEC60825-1 (2007). 

Environment Conditions This instrument is intended for indoor use in an installation category II, pollution degree 2 
environment. It is designed to operate within a temperature range of 0 °C – 40 °C 
(32 °F – 105 °F) at a maximum relative humidity of 80% and at altitudes of up to 
2000 meters.

This module can be stored or shipped at temperatures between -40 °C and +70 °C. 
Protect the module from temperature extremes that may cause condensation within it.

Before Applying Power Verify that all safety precautions are taken. The power cable inlet of the instrument serves 
as a device to disconnect from the mains in case of hazard. The instrument must be 
positioned so that the operator can easily access the power cable inlet. When the 
instrument is rack mounted the rack must be provided with an easily accessible mains 
switch.

Line Power Requirements The Keysight M8131A operates when installed in an Keysight AXIe mainframe.

http://www.keysight.com
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Do Not Operate in an
Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the
Instrument Cover

Operating personnel must not remove instrument covers. Component replacement and 
internal adjustments must be made only by qualified personnel. 

Instruments that appear damaged or defective should be made inoperative and secured 
against unintended operation until they can be repaired by qualified service personnel.

Ground the Instrument To minimize shock hazard, the instrument chassis and cover must be connected to an 
electrical protective earth ground. The instrument must be connected to the ac power 
mains through a grounded power cable, with the ground wire firmly connected to an 
electrical ground (safety ground) at the power outlet. Any interruption of the protective 
(grounding) conductor or disconnection of the protective earth terminal will cause a 
potential shock hazard that could result in personal injury.
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Instrument Markings

The Table 1 lists the definitions of markings that may be on or with the product.

Table 1  Instrument Markings

Marking Description

The instruction documentation symbol. The product is marked with this symbol 
when it is necessary for the user to refer to the instruction in the documentation.

Frame or chassis ground terminal. Typically connects to the equipment’s metal 
frame.

KC is the Korean certification mark to demonstrate that the equipment is Class A 
suitable for professional use and is for use in electromagnetic environments outside 
of the home. 

Indicates that anti-static precautions should be taken.

China Restricted Substance Product Label. The EPUP (environmental protection use 
period) number in the center indicates the time period during which no hazardous 
or toxic substances or elements are expected to leak or deteriorate during normal 
use and generally reflects the expected useful life of the product. 

The RCM mark is a registered trademark of the Australian Communications and 
Media Authority.

The CSA mark is a registered trademark of the CSA International.
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Compliance and Environmental Information

Table 2  Compliance and Environmental Information

The CE mark is a registered trademark of the European Community (if accompanied 
by a year, it is the year when the design was proven). This product complies with all 
relevant directives. 

Universal recycling symbol. This symbol indicates compliance with the China 
standard GB 18455-2001 as required by the China RoHS regulations for 
paper/fiberboard packaging.

The Keysight email address is required by EU directives applicable to our product.

Marking Description

Safety Symbol Description

This product complies with WEEE Directive (2002/96/EC) marking requirements. 
The affixed label indicates that you must not discard this electrical/electronic 
product in domestic household waste.

Product Category: With reference to the equipment types in WEEE Directive Annex I, 
this product is classed as a “Monitoring and Control instrumentation” product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more 
information.
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This chapter provides an overview of M8131A digitizer module.

M8131A Overview

The Keysight M8131A is a 16/32 GSa/s digitizer with high bandwidth and 
channel density. It offers up to 1.6 GSa waveform memory. The M8131A is 
ideally suited to address following key applications: 

• Wideband RF/μW – analyses extremely wideband RF signals with an 
instantaneous bandwidth of DC to 12.5 GHz for aerospace/defense and 
communication applications. 

• Physics, chemistry, and electronics research – analyses any 
mathematically defined arbitrary waveforms, ultra-short yet precise 
pulses and extremely wideband chirps. 

• Gapless optical streaming of 10-bit digitized data to DSP module, AWG 
or storage system for radar, electronic warfare, satellite or 5G.

Key Features

The M8131A is a digitizer with high sample rate, bandwidth, and channel 
density: 

• Wide bandwidth

• 4 channels 6.5GHz, sample rate 16 GSa/s on each channel or

• 2 channels 12.5GHz, sample rate 32 GSa/s on each channel 
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• Vertical resolution: 10 bits 

• Outstanding signal fidelity with respect to SFDR, ENOB, harmonic 
distortion

• Full speed 4 x 16 GSa/s or 2 x 32 GSa/s gapless optical streaming via 
ODI (standardized Optical Data Interface), e.g. to an external storage 
system or customer‘s device or DSP module

• Total ODI streaming throughput: 4 x 160 GBit/s equals 640 GBit/s

• Real-time DDC and decimation

• On board memory 1.6 GSa per module

• Form factor: 2-slot AXIe module controlled via external PC or 
embedded AXIe system controller M9537A 

Feature Options

The following feature options are available for M8131A:

Table 3  M8131A feature options

Instrument Options

The following instrument options are available for M8131A:

Table 4  M8131A instrument options

Option Functionality

STR Streaming: access to ODI interfaces

DDC Digital Down Conversion

SEG Segmentation

Option Bandwidth Maximum Sample Rate Inputs

011, 012, 014 1.6 GHz 4 GSa/s Single ended inputs, adjustable 
sensitivity.

061, 062, 064 6.5 GHz 16 GSa/s

131, 132 12.5 GHz 32 GSa/s

FD1, FD2, FD4 12.5 GHz 32 GSa/s Differential inputs, fixed sensitivity.
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Front Panel

Figure 1 on page 21 illustrates the front panel of the M8131A instrument.

Figure 1 M8131A front panel

The M8131A front panel has the following input/output ports: 

Inputs/Outputs

• Input - The four analog input ports (In 1/2/3/4) can be used to receive 
the analog data.

• ODI - The four Optical Data Interface ports (ODI 1/2/3/4) can be used 
for optical data streaming. 

• Trig In - The Trigger Input can be used for external triggering. 
Triggering source can be an external pulse generator connected. This 
will be used only when the trigger source is “Trigger Input”.

• Trig Out - The Trigger Output can be used to trigger external 
instruments or DUTs.

• Sync In - The Sync Input can be used to synchronize two or more 
modules to a common system clock. It is connected to the Sync Out of 
another module.

• Sync Out - The Sync Output can be used to synchronize two or more 
modules to a common system clock. It is connected to the Sync In of 
another module.

• Sample Clk In - The Sample Clock Input can be used, if an external 
clock source shall be used to clock the analog to digital to converters.

• Sample Clk Out - The Sample Clock Output can be used to output the 
clock signal from the internal sample clock or the sample clock input.

When an internally generated sample clock of the M8131A is used, the 
Sample CLK Out must be connected with Sample Clk In with a 
semi-rigid cable as shown in the Figure 2 on page 22. However, if an 
external 8 GHz sample clock is used, the semi-rigid cable is not 
required. 
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Figure 2 Sample Clk Out/In connection

• Ref Clk In - The Reference Clock Input can be used to synchronize to an 
external clock.

• Ref Clk Out - The Reference Clock Output can be used to synchronize a 
DUT to the M8131A.

• FPGA Config - The FGPA Config functionality is for future use and is 
currently not supported.

• Control In/Out - The Control In/Out functionality is for future use and is 
currently not supported. 

Semi-rigid cable
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LEDs

The M8131A front panel has the following LEDs:

• Status LEDs

The “Fail” and “Access” LEDs are available at the front panel to indicate 
the status of the M8131A module:

• The green “Access” LED indicates that the controlling PC exchanges 
data with the M8131A module.

• The red “Fail” LED has following functionality:

• It is ‘ON’ for about 30 seconds after powering the AXIe chassis.

• After about 30 seconds the LED is switched ‘OFF’. If an external 
PC is used to control the AXIe chassis, this PC can be powered 
after this LED has switched OFF.

• During normal operation of the module this LED is ‘OFF’. In 
case of an error condition such as e.g. a self-test error, the LED 
is switched ‘ON’.

• In case the output relay has shut-off because of an external 
overload condition, this LED flashes.

Related Documents

To access documentation related to the Keysight M8131A digitizer, use 
one of the following methods:

• CD - Browse the product CD for M8131A documentation.

• Start > All Programs > Keysight M8131 > Keysight M8131 
Documentation - Provides links to all product documentation.

• Go to the product web site (http://www.keysight.com/find/M8131A) 
and browse the manuals under Document Library tab.
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Additional Documents

Additional documentation can be found at:

• http://www.keysight.com/find/M8131A for documentation describing
how to calibrate the M8131A using the N2136A calibration module.

• http://www.keysight.com/find/M9502A for 2-slot chassis related
documentation.

• http://www.keysight.com/find/M9505A for 5-slot chassis related
documentation.

• http://www.keysight.com/find/M9506A for 5-slot chassis related
documentation.

• http://www.keysight.com/find/M9514A for 14-slot chassis related
documentation.

• http://www.keysight.com/find/M9537A for embedded AXIe controller
related documentation.
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This chapter explains the steps required to install M8131A software 
package.
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2 M8131A Software Installation

Pre-Requisites 

The following are the pre-requisites for installing Keysight M8131A 
software:

The supported operating systems are:

• Windows 10 (32 bit or 64 bit)
 

Ensure that you have Keysight IO Libraries Suite 2017 Update 1 or higher 
installed on your system. The Keysight IO Libraries Suite can be found on 
the CD that is part of shipment content or at 
http://www.keysight.com/find/iosuite

NOTE
Even if a non-Keysight VISA is already installed on your PC, it is still 
necessary to install the Keysight IO Libraries Suite. The Keysight IO 
Libraries Suite will install as “secondary” VISA in this case.
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Installation Process

Follow the given steps to install Keysight M8131A software on your 
system:

1 Double-click the executable (M8131_Setup.exe). This executable file is 
available either on CD or Web.

NOTE
The installer will first check and list some pre-requisites. Click Install to 
install them. It is possible that your PC requests a reboot during this 
step. Reboot your PC, if requested.
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2 The Keysight M8131A Setup will prepare the InstallShield Wizard for 
the installation process. The following window will appear.

3 Follow the on-screen instructions to begin the installation process.

Click Next.
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4 We recommend you to read the document to check if your hardware 
configuration is supported.

Click Next to proceed to the license agreements.
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5 Accept the terms of Keysight software end-user license agreement and 
click Next.

6 Select Yes if you want to read the post-installation instructions when 
finished. 

Click Next to select setup type.
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7 Select a setup type either Complete or Custom. Click Next.
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8 If you select Custom and click Next, you can specify which optional 
features will be installed:

9 Click Next to begin installation.
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10 The Setup Wizard will now install M8131 beginning with the kernel 
driver installation. If you have clicked “Always trust Keysight” before 
you won’t get this dialog anymore.
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11 The Keysight M8131A will configure the new software installation.
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The following screen will appear once the Keysight M8131A software is 
successfully installed on your system.

Click Finish to restart your system. Do not connect the AXIe chassis to 
your system using the PCIe or USB cable during this reboot.
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12 This completes the Keysight M8131A software installation.
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Post Installation Steps

Follow the post installation steps as shown below: 

1 Shut down PC and instrument.

2 Connect the instrument to the PC using the PCIe or USB cable.

3 Switch on the instrument. Wait until the “Access” LED of the M8131A 
has switched from red to green.

4 Switch on the PC.

5 The PC should automatically recognize the instrument.

Check this in the device manager; e.g. via Start > Control Panel > Device 
Manager, or right-click Computer > Manage > Device Manager:

• In case of PCIe: 

The instrument should be visible in the device tree as Keysight 
Technologies Modular Devices > M8131A 

• In case of USB: 

The instrument should be visible in the device tree as Keysight Modular 
Platform (AMP/AXIe) > Keysight Technologies USB AMP/AXIe Chassis. 

6 (PCIe only) Check if the M8131 is also visible in the Connection Expert. 
The connection expert can be opened by clicking its icon in the system 
tray.

NOTE
If M8131A is already powered up and connected to PC using the PCIe, 
just reboot the PC and start with step 5. No such reboot step is required 
in case of USB connection. 

NOTE
In case of PCIe, post installation steps must be followed strictly in the 
same order as mentioned for successful connection of the PC with 
M8131A. However, in case of USB no such restriction is applicable i.e. 
the PC can be powered before the M8131A is turned ON. 

NOTE
Your PC might request a reboot. Reboot your PC, if requested.
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If something went wrong and the instrument is not showing in the PXI 
section, it may be necessary to reboot the PC once more.

NOTE
In systems with a PCIe connection to the chassis, it is strongly 
recommended to switch-off Windows’ “fast startup”. Otherwise 
configuration changes may not get detected correctly.

1 Right-click the Start Menu, and then select System.
2 Under the System pane, click Power & Sleep.

3 Under the Related settings option, click Additional power settings.

4 Click Choose what the power buttons do option.
5 Under the Change settings that are currently unavailable pane, 

ensure that Turn on fast startup is not selected.

The steps above may vary depending on your Windows version. 
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How to use M8131A Instrument

In order to use the instrument:

1 If you use a PCIe link to control the M8131A, the AXIe chassis must be 
switched on before you start the PC. If you use an USB link to control 
the M8131A, it’s not mandatory that the AXIe chassis is powered and 
has booted prior to turn-on the PC.

2 Start the M8131A Soft Front Panel (Start Menu > Keysight M8131 > 
Keysight M8131 Soft Front Panel). The user interface will display the 
VISA resource strings for different kinds of connection. Please note that 
the hardware resource strings will be not shown if the “Simulation 
Mode” check box is selected.

3 Using the appropriate VISA resource string you can: 

• Start the Soft Front Panel (Start > All Programs > Keysight M8131 
> Keysight M8131 Soft Front Panel). 

• Control the instrument with your own application by adding it as a 
LAN instrument in the Keysight Connection Expert 
(TCPIP0::localhost::…) and control it using SCPI (with e.g. the 
Interactive IO or your own application).

You must start the M8131A Soft Front Panel in order to send SCPI 
commands to the instrument. 
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M8131A Maintenance

This system should be serviced only by authorized personnel.

ESD Protection

Electrostatic discharge (ESD) can damage or destroy electronic 
components. All work on electronic assemblies should be performed at a 
static-safe work station. The following list and figure shows an example of 
a static-safe work station using two types of ESD protection. Purchase 
acceptable ESD accessories from your local supplier.

• Conductive table-mat and wrist-strap combination.

• Conductive floor-mat and heel-strap combination.

WARNING
Using controls or adjustments or performing procedures other than 
those specified in the documentation supplied with your equipment can 
result in hazardous radiation exposure.

CAUTION
All the connectors are very sensitive to electrostatic discharge (ESD). 
There are also several exposed components on the PCAs, on both sides 
of M8131A, which can be touched accidentally while handling the unit 
and can risk damage to the instrument, due to ESD. When you connect a 
device or cable that is not fully discharged to these connectors, you risk 
damage to the instrument and expensive instrument repairs.

CAUTION
Electrostatic discharge (ESD) can damage the circuits of the M8131A. 
Avoid applying static discharges to the front-panel connectors. Avoid 
touching the front-panel connectors without first touching the frame of 
the instrument. Be sure the instrument and all connected devices (DUT, 
etc.) are properly earth-grounded (to a common ground) to prevent 
buildup of static charge and electrical over-stress.
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Figure 3 ESD protection

Both types, when used together, provide a significant level of ESD 
protection. Of the two, only the table-mat and wrist-strap combination 
provides adequate ESD protection when used alone. To ensure user safety, 
the static-safe accessories must provide at least 1 MW of isolation from 
ground.

WARNING
These techniques for a static-safe work station should not be used when 
working on circuitry with a voltage potential greater than 500 volts.
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Power and Ventilation Requirements

For power and ventilation requirements, refer to:

• http://www.keysight.com/find/M9514A for 14-slot chassis related
documentation.

• http://www.keysight.com/find/M9505A for 5-slot chassis related
documentation.

• http://www.keysight.com/find/M9506A for 5-slot chassis related
documentation.

• http://www.keysight.com/find/M9502A for 2-slot chassis related
documentation.

Thermal Protection

Overheating Detection

The instrument monitors its internal temperature. If the temperature 
exceeds approximately 80°C the power supply is switched off. The 
instrument will not turn on automatically if the temperature is decreasing 
again. 

Fan Failure

If a fan is broken or prevented from operating by a blockage the 
temperature will increase. When the temperature exceeds approximately 
80°C the overheating detection switches off the instrument for safety 
reasons. For reliability it is recommended to send instruments with broken 
or defective fans immediately to Keysight Service for repair.

Battery

The M8131A does not have a battery.

Operating Environment

For details on operative environment for M8131A, refer to the section 
Operating Environment on page 197.
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Launching the M8131A Soft Front Panel

There are two ways to launch the M8131A Soft Front Panel:

1 Select Start Menu > All Programs > Keysight M8131 > Keysight 
M8131 Soft Front Panel from the Start menu.

2 From the Keysight Connection Expert select the discovered M8131 
module, select the “Installed Software” tab and press the “Soft Front 
Panel” icon. Please note that only instruments connected via PCIe are 
shown in the Keysight Connection Expert.

The following Connect to Instrument dialog will appear:

Figure 4 M8131A connected to PC

This dialog shows the addresses of the discovered M8131A modules. 
Select a module from the list and press “Connect”.

If no M8131A module is connected to your PC, you can select “Simulation 
Mode” to simulate an M8131A module.



Keysight M8131A 16/32 GSa/s Digitizer User’s Guide 45

M8131A User Interface 3

 Figure 5 M8131A in simulation mode

Next, a M8131A software startup screen will be displayed as shown in 
Figure 6 on page 46.
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Figure 6 M8131A startup screen



Keysight M8131A 16/32 GSa/s Digitizer User’s Guide 47

M8131A User Interface 3

 

Command Line Arguments

(See Communication on page 48 for details about /Socket, /Telnet, /Inst, 
/HiSLIP, /AutoID, /NoAutoID, /FallBack).

Table 5  Command line arguments

Option Description

/Socket socketPort Set the socket port at which the Soft Front Panel waits for SCPI commands.

/Telnet telnetPort Set the telnet port at which the Soft Front Panel waits for SCPI commands.

/Inst instrumentNumber Set the instrument number (instN, hislipN) at which the Soft Front Panel waits for SCPI commands on 
VXI-11.3 and HiSLIP connections (if not specified with /HiSLIP).

/HiSLIP hislipNumber Set the instrument number for HiSLIP SCPI communication. If not specified, the same number as for 
VXI-11.3 is used.

/AutoID Automatically select ports and numbers for the connections (default behavior).

/NoAutoID Disable the default behavior; i.e. do not automatically select ports and numbers for the connections.

/FallBack Try to find unused ports and number if starting a server fails.

/NoSplash Don't show the splash screen.

/Minimized Start with the SFP window minimized to the Windows task bar.

/Title “title” Additional information shown in the SFP window title.

/OutputDir Set the output directory for the log file and temporary files.

/r resourceName Visa PXI resource string of the module to connect to, e.g. PXI12::0::0::INSTR. “auto” selects the next free 
instrument.
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Communication

Depending on the command line arguments /Socket, /Telnet, /Inst, 
/AutoID, /NoAutoID, /FallBack, the Soft Front Panel starts several servers 
to handle SCPI commands. (Refer to the table above.)

/Socket, /Telnet, /Inst, /HiSLIP: If -1, do not start the respective servers

Defaults:

• Socket port: 5025 (e.g. TCPIP0::localhost::5025::SOCKET)

• Telnet port: 5024

• HiSLIP: 0 (e.g. TCPIP0::localhost::hislip0::INSTR)

• VXI-11.3: 0 (e.g. TCPIP0::localhost::inst0::INSTR)

/FallBack: If starting a server fails because of a conflict, try using another 
port or number

• HiSLIP, VXI-11.3: increase the index until a server can be started 
successfully

• Socket, Telnet: start with port 60000, then increase it until the servers 
can be started successfully. If neither socket nor telnet is disabled, the 
Soft Front Panel tries to start the servers on two consecutive ports 
(socket port = telnet port + 1)

/AutoID: Automatically select ports and number for the connections, 
which are unique per instrument.

This is the default behavior; it is not necessary to specify this argument on 
the command line.

If only one AXIe module is connected to this PC and it is an M8131A 
module, first try to use the command line arguments /Socket, /Telnet, 
/Inst, or their respective default values if they are not specified. If starting 
the servers fails, proceed with the steps below.

/Socket, /Telnet, /Inst, /HiSLIP are ignored (unless they are -1 and a 
server is disabled)

If the Soft Front Panel detects more than one AXIe module, use a special 
mechanism to obtain a number for the HiSLIP and VXI-11.3 servers, which 
makes sure that the Soft Front Panel uses always the same VISA resource 
string per module

The socket and telnet port are then calculated from the HiSLIP index:

• telnet port = 60000 + 2 * <HiSLIP index>

• socket port = 60000 + 2 * <HiSLIP index> + 1
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/NoAutoID: Do not automatically select ports and number for the 
connections, use the values specified with /Socket, /Telnet, /Inst, /HiSLIP 
or their respective default values instead.

If both /NoAutoID and /AutoID are specified, /AutoID overrides /NoAutoID.

NOTE
Ports may already be in use by Windows or other applications, so they 
are not available for M8131A.

NOTE
The first port not assigned by IANA is 49152 (IANA, Internet Assigned 
Numbers Authority, http://www.iana.org)
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M8131A Soft Front Panel

The M8131A Soft Front Panel and its elements are illustrated in 
Figure 7 on page 50.

Figure 7 M8131A user interface

The M8131A Soft Front Panel includes the following elements:

1 Title Bar

2 Menu Bar

3 Tool Bar

4 Trace Window

5 Parameters Window

6 Lower Pane

7 Status Bar
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Title Bar

The title bar contains the standard Microsoft Windows elements such as 
the window title and the icons for minimizing, maximizing, or closing the 
window.

Menu Bar

The menu bar consists of various pull down menus that provide access to 
the different functions and launch interactive GUI tools.

The menu bar includes the following pull down menus:

• File

• View

• Utilities

• Trace

• Tools

• Windows

• Help

Each menu and its options are described below.

File Menu

The File menu includes the following selections:

File > Connect… Opens the “Connect to Instrument” dialog. See Launching the 
M8131A Soft Front Panel on page 44.

File > Save Configuration As… Saves configuration as a text file.

File > Load Configuration… Loads the previously saved configuration file.

File > Export Waveform Exports the data of a channel to a text file with a header. See 
:MMEMory:STORe:WAVeform  command for a description of the 
file format.

File > Exit Exits the M8131A application.
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View Menu

The View menu includes the following selections:

Utilities Menu

The Utilities menu includes the following selections:

Trace Menu

The Trace menu includes the following selections:

View > Hide Minimizes the GUI to notify icon.

Utilities > Calibration Opens the Calibration dialog. For instructions on how to calibrate the 
instrument, see Calibration Manager on page 74.

Utilities > Identify Identifies the instrument by flashing the green “Access” LED on the front 
panel for a certain time.

Utilities > Reset Resets the instrument, reads the state and updates all fields.

Utilities > Self Test… Opens a window to start the self-test and display the result after completion. 
Not functional in the current software release.

Trace > Time Window Opens a new instance of time window.

Trace > Frequency Window Opens a new instance of frequency window.
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Tools Menu

The Tools menu includes the following selections:

Tools > Acquisition Switch to the “Acquisition” tab on Parameters window if it is already open. If 
not, it adds “Acquisition” tab first. For details, see Acquisition Tab on 
page 64.

Tools > Trigger Switch to the “Trigger” tab on Parameters window if it is already open. If not, 
it adds “Trigger” tab first. For details, see Trigger Tab on page 67.

Tools > Clock Switch to the “Clock” tab on Parameters window if it is already open. If not, it 
adds “Clock” tab first. For details, see Clock Tab on page 69.

Tools > IOs Switch to the “IOs” tab on Parameters window if it is already open. If not, it 
adds “IOs” tab first. For details, see IOs Tab on page 70.
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Windows Menu

The Windows menu allows you to change the layout/arrangement of time 
and frequency windows. It provides the following selections:

Windows > Close All Windows Closes all trace windows.

Windows > Cascade Arranges the open trace windows as cascaded tabs, so that the content of 
one tab at a time is visible.

Windows > Tile Horizontally Aligns the multiple opened windows in a horizontal sequence. The following 
figure shows the horizontal sequence of two different windows.
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Help Menu

The Help menu includes the following selections:

Windows > Tile Vertically Aligns open windows in a vertical sequence. The following figure shows the 
vertical sequence of two different windows.

Help > User Guide Opens the M8131A User’s Guide.

Help > Examples Opens the Examples directory.

Help > Online Support Opens the instrument’s product support web page.

Help > About Displays product information including version number, build date, build 
info, installed licenses, available options and web links for M8131A 
information and support.
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Tool Bar

The tool bar provides the following convenient functions:

Capturing This is an icon to mark the buttons to its right to be related to capturing. A 
capture is done via Single and Run buttons. Its functionality expects at least 
one selected channel (a channel can be selected from Acquisition Tab > 
Channel Parameters > Display On check-box). 
After completion of every capture, the current data buffer is cleared and 
replaced by the new measured values, and the corresponding time and 
frequency signals are plotted in trace windows.

Run This icon enables you to start a repetitive capturing.

Stop This icon enables you to stop a capture.

Single This icon enables you to start a single capture.

Use mouse to control marker If selected, a marker is added to the selected trace. Using the mouse, the 
marker can be moved on the trace in order to read the value of desirable 
points. To set the marker to a different channel, right click on graph panel 
(the black area) and select the desirable channel number from Marker > Set 
to Channel X. Set to Channel X is disabled if its corresponding channel 
number from Acquisition Tab > Channel Parameters > Display On check-box 
is not selected.

Use mouse to zoom Use this tool to select a rectangular area of a trace for closer examination.

Auto scale once Auto Scale adjusts All open windows’ scaling so that the whole traces are 
visible. An auto-scale for one window can be done via Auto Scale inside 
graph panel’s context menu (i.e. right-click and use context menu).
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Lower Pane

The lower pane provides the following options:

Use mouse to pan Use the pan/hand tool to move the area of viewing in the desired direction.

Streaming This is an icon that marks the buttons to its right to be related to streaming. 
Click the start button  to start the streaming process. Once the process 
has started, it can be terminated by pressing the stop button .

Start Streaming This icon enables you to start a streaming.

Show Status Window Opens the Status Window. This feature is currently not implemented.

Show Error List Window Opens the window that shows the list of errors and warnings. For details, see 
Errors List Window on page 58.
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Errors List Window

Use this window to view errors, warnings, and information. 

Figure 8 Error list window

For each error, it shows error details i.e. notification type, time stamp and 
description. 
It has the following controls, signs, and columns:

(Clear All) Click this button to clear all the errors from the errors list 
window.

Open On Error Click this toggle button to automatically open the errors list 
window whenever an error occurs (default) or not. 

Copy Click this button to copy the selected message(s). 

Select All Click this button to select all messages inside the list.
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Status Bar

The status bar contains the following fields from left to right:

• Connection state:

• “Not Connected” – No instrument is connected. 

• “Connected: <Instrument resource string>” – An instrument is 
connected. The resource string, for example PXI36::0::0::INSTR is 
displayed. 

• “Simulation Mode” – No real instrument is connected. The user 
interface is in simulation mode. Click this field to open the 
Instrument Selection Dialog.

• Instrument status - Displays the instrument status, for example “Reset 
complete” after issuing a reset command. 

Parameters Window

The Parameters Window provides various tabs which are used to 
configure the parameters of the M8131A instrument. These tabs include: 
Acquisition, Trigger, Clock, and IOs.
Figure 9 on page 60 illustrates an example of the Parameters Window.
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Figure 9 Parameters window

NOTE
You can use the numeric controls to adjust the values and units. For 
details on how to use numeric control, refer to the section Numeric 
Control Usage on page 72.
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Trace Window

The trace window contains time and frequency graph panels. A graph 
panel is an area on which the plotted graphs for a signal is shown. 

Figure 10 Frequency graph
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Figure 11 Time graph

The context-menu of a graph panel provides the following features which 
are effective on the current graph only:

Figure 12 Context menu of a graph
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• Channel Selection: Turns on/off the display of relevant channel. If 
"Display On" check-box for one Channel is deselected (Acquisitions > 
CHX > Display On), its corresponding field inside context-menu is not 
accessible (grayed-out).

• Markers: It sets a marker on desirable trace. Refer to toolbar menu > 
control marker for more information.

• Auto Scale: It scales the current graph panel. Refer to toolbar menu > 
Auto-scale once, for more information.

• Show Grid: Use this check-box to show/hide grids from the graph.

• Clear Marker: It clears the selected marker from the graph panel. It is 
only enabled when a marker is selected. 
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Acquisition Tab

The Acquisition tab manages acquisition and its associated parameters. It 
includes the General Parameters, Timestamp Snapshot, and Channel 
Parameters.

Figure 13 Acquisition tab

General parameters

• Sample Rate - Based on available options, a sample rate of 16 GSa/s or 
32 GSa/s can be selected. 

• Mode - The following two modes are available:

• Direct Mode - The direct mode is available for both 16 GSa/s or 
32 GSa/s sample rates.
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• DDC Mode - The DDC (Digital Down Conversion) mode is available 
for both 16 GSa/s or 32 GSa/s sample rates.

• Decimation Factor - The decimation factor depends upon the sample 
rate and mode. The following decimation factors are available:

• Streaming Mode - Enables you to select the appropriate streaming 
mode. The following streaming modes are available:

• Continuous

• Continuous Packetized

• Segmented Fixed

• Segmented Variable

For more information, refer to Streaming and Segmentation on 
page 85.

Timestamp Snapshot

In streaming segmented modes (i.e., Continuous Packetized, Segmented 
Fixed, and Segmented Variable), one timestamp is assigned to each 
packet. It is saved in the packet header, and it represents the moment that 
the trigger arrived, and the packet started to capture.

• Local Time - Shows the last captured packet's timestamp as the local 
time and in seconds accuracy. In a non-segmented mode, this field is 
empty.

• Raw - This raw timestamp represents the number of picoseconds 
elapsed since midnight of January 1, 1970. In a non-segmented mode, 
this field is empty. 

Sample Rate Mode Decimation Factor

16 GSa/s Direct 1, 2, 4

16 GSa/s DDC 4, 8, 16, 32, 64, 128, 256, 512

32 GSa/s Direct 1,2, 4

32 GSa/s DDC 4, 8, 16, 32, 64, 128, 256, 512

NOTE
With option 01x the minimum decimation factor is 4, i.e. the effective 
maximum sample rate is 4GSa/s.
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Channel Parameters

• Channel 1/2/3/4 - Selects the channel. The availability of channels 
depends upon the sample rate. For the 16 GSa/s sample rate, all four 
channels are available. However, in 32 GSa/s mode only two channels, 
1 and 2, are available.

• Display On: Turns on or off the waveform memories for corresponding 
channel number and display its content in trace panel(s). The Single 
and Run buttons are functional only when at least one channel is 
selected.

If the input signal’s digitized value exceeds the maximum allowed 
range, clipping occurs. Depending on the number of available 
channels and the input channel in which the clipping has occurred, this 
would be marked with OV1, OV2, OV3 or OV4 labels in time-domain 
display. To avoid the clipping, reduce the amplitude of the input signal 
or alternatively, increase the Range parameter up to the maximum 
allowed value. 

• DDC Center Frequency- Sets the digital down conversion center 
frequency. The DDC Center Frequency parameter has a range of -8 
GHz to 8 GHz when the Sample Rate is 16 GSa/S and a range of -16 
GHz to 16 GHz when the Sample Rate is 32 GSa/S.

• Frontend Settings - The frontend settings are available, depending 
upon the installed options (see Instrument Options on page 20). These 
settings allow you to set the signal offset and range.
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Trigger Tab

The Trigger tab provides the trigger settings to M8131A module.

Figure 14 Trigger tab

Settings

• Source - Select the trigger source for sweep mode triggering. The 
following options are available:

• Trigger Input - Signal acquisition starts when a positive/negative 
slope is received on the trigger input port of M8131A.

• Channel 1 - Signal acquisition starts when a positive/negative slope 
is received on Channel 1 of M8131A.

• Channel 2 - Signal acquisition starts when a positive/negative slope 
is received on Channel 2 of M8131A.

• Channel 3 - Signal acquisition starts when a positive/negative slope 
is received on Channel 3 of M8131A.

• Channel 4 - Signal acquisition starts when a positive/negative slope 
is received on Channel 4 of M8131A.

• Sync Input - Signal acquisition starts when a positive/negative slope 
is received on the Sync input port of M8131A.
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• Slope - Select a trigger input slope value from the Slope drop-down 
list. The following options are available:

• Positive - Rising edge

• Negative - Falling edge

• Sweep Mode - Select the trigger sweep value from the Sweep Mode 
drop-down list. The following options are available:

• Auto - When a trigger event does not occur in a certain time, the 
instrument automatically forces a trigger, which causes the 
instrument to sweep.

• Triggered - When a trigger event occurs, instrument will sweep.

• Holdoff Type - Select an option from the Holdoff Type drop-down list. 
The following options are available:

• Normal - Once the hold off time is elapsed, the M8131A waits for a 
trigger and then it triggers only after the trigger is received.

• Above - Ignore triggers until the signal is above the threshold value 
(for negative slope and triggered sweep mode) for hold off time. 
Once the hold off time is elapsed, the M8131A triggers the signal.

• Below - Ignore triggers until the signal is below the threshold value 
(for positive slope and triggered sweep mode) for hold off time. Once 
the hold off time is elapsed, the M8131A triggers the signal.

• Holdoff Time - The time period for which any trigger will not work. No 
trigger is received during that time count.

• Thresholds - Enter the threshold values for the following:

• Trigger In - This parameter appears when the option Trigger Input is 
selected from the Source drop-down list. Signal acquisition starts 
when a positive/negative slope is received on the trigger input port 
of M8131A.

• Channel 1/2/3/4 - This parameter appears when the option Direct 
Mode is selected under the Acquisition tab and the respective 
channel is selected from the Source drop-down list. Signal 
acquisition starts when a positive/negative slope is received on 
Channel 1/2/3/4 of M8131A.

• IFMagnitude 1/2/3/4 - This parameter appears when the option 
DDC Mode is selected under the Acquisition tab, and the respective 
channel is selected from the Source drop-down list. Signal 
acquisition starts when a positive/negative transition of the power 
level expressed in dBm is received on Channel 1/2/3/4 after a time 
period. For more information, refer to :TRIGger:LEVel:IFMagnitude 
on page 181.
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Clock Tab

The Clock tab provides the clock settings to M8131A module.

Figure 15 Clock tab

Input Clock Settings

• Ref. Clock Source - A clock reference input is provided on the front 
panel of the M8131A module. It is used as the clock reference for all 
four analog channels of that M8131A. The options are:

• Internal

• External 10MHz

• External 100MHz



70 Keysight M8131A 16/32 GSa/s Digitizer User’s Guide

3 M8131A User Interface
 

IOs Tab

The IOs tab provides input and output settings for analog and optical data 
interfaces.

Figure 16 IOs tab
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• Optical Data Interfaces (ODI) - Select a tab from ODI1, ODI2, ODI3, or 
ODI4 to set the respective parameters.

• Enable Port - The respective ODI ports can be activated/deactivated by 
selecting this check-box. An error for loss of signal will be shown, if a 
check-box is asserted without making the physical connections.

• ODI Parameters - The following ODI Parameters are available:

• Transmit Max Burst - This is the maximum burst size.

• Lane Rate - Currently R141 is the only supported lane rate.

• Direction - The direction is always Producer.

• TX Flow Control - The only available choice is None, i.e. no flow 
control. 

• RX Flow Control - The only available choice is None, i.e. no flow 
control. 

• Statistics - Display the ODI statistics. The following options are 
available:

• Status – It is a hexadecimal value corresponds to a 32-bit register, 
which shows the current status of the port. Hover on the numeric 
field to open the tooltip which provides information about every bit 
and its current value.

• Bytes Sent- Number of bytes sent over the ODI link.

• Bytes Received - Number of bytes received over the ODI link.

• Bad Bursts Received - Number of bad bursts received over the ODI 
link. 

• Tx Flow Holdoffs - The number of ODI clock cycles during which the 
transmitter was held off, irrespective of whether there was 
something to transmit or not.

• Refresh Statistics: Updates the statistics.

• Selftests - This option tests whether the particular ODI port is 
functional or not. Connect a loopback connector to the respective port 
and run a self-test. It will test whether the port allows proper 
transmission of data. The test reports the connection status, and in 
case of failure, the status of each individual lane. All failed test steps 
are shown. Possible errors are PLL lock failures, burst, overflow, 
underflow, CRC, and alignment errors
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Working with M8131A Front Panel

Numeric Control Usage

The numeric control is used to adjust the value and units. Whenever you 
bring the mouse pointer over the numeric control, a tool tip appears which 
shows the possible values in that range.

Figure 17 Tool tip showing possible values in the range

The numeric controls can be used in the following ways:

Use the up/down arrows to change the value. The control automatically 
stops at the maximum/minimum allowed value.

You can increase or decrease the value starting at a specific portion of the 
value. To do this, place the cursor to the right of the targeted digit and use 
the up/down arrows. This is especially useful when changing a signal 
characteristic that is immediately implemented, and observing the result in 
another instrument. For example, you can change the signal generator’s 
frequency by increments of 10 MHz and observe the measured result in a 
signal analyzer:

Figure 18 Typing directly into the field

Type directly into the field and press the Enter key. If you enter a value 
outside the allowed range, the control automatically limits the entered 
value to the maximum or minimum allowed value.

When you type the value, you can type the first letter of the allowed unit of 
measure to set the units. For example, in the Frequency control you can 
use "H", "K", "M", or "G" to specify Hz, KHz, MHz or GHz , respectively. 
(The control is not case sensitive.)
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The controls allow scientific notation if it is appropriate to the allowed 
range. Type the first decimal number, enter an "E", and omit any trailing 
zeroes. For example, in the Frequency control you can type 2.5e+9 and 
press [Enter] to set the frequency to 2.5 GHz. (The plus sign is 
automatically inserted if it is omitted.)

Window Controls Usage

The window options allow you to float or dock anywhere in the application 
window. It provides quick access to logically grouped features from one 
location. For example, you can select and generate various layouts from 
the single window.

You can move a window anywhere on the screen or to a different monitor. 
You can also close the floating windows.
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Calibration Manager

Calibration is required to compensate some hardware distortions and to 
have a proper symmetric signal leveled at zero volt. After a successful 
calibration, the system stores the results and reloads them upon a power 
cycle. Refer to the ‘Keysight N2125A/6A/7A and N2136A Calibration 
Modules’ User’s Guide that can be found at 
http://www.keysight.com/find/M8131A for documentation describing how 
to calibrate the M8131A using the N2136A calibration module.

The calibration process differs, depending on the module type – single 
ended or differential inputs.

• Single ended: Connect N2136A calibration module to channel one, 
start calibration step, wait until it is finished, connect the module to the 
next channel.

• Differential inputs: One calibration step, start it and wait until it is 
finished.

NOTE
The M8131A 16/32 GSa/s digitizer with single ended input (options 
-011, -012, -014, -061, -062, -064, -131, -132) requires a N2136A 
calibration module. The M8131A 16/32 GSa/s digitizer with differential 
input (options -FD1, -FD2, -FD4) does not require a calibration module. 
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Figure 19 Calibrated zero volts on all channels with 50-ohm resistor caps installed
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The calibration dialog is used to calibrate M8131A module. You can also 
save and load the calibration for future use. 

Figure 20 Calibration dialog

Starting Calibration Process

To start the calibration:

1 Go to Utilities > Calibration.

The Calibration Manager dialog box appears.

2 Click on the Start Calibration button. The Process Result will display 
the message “Calibration has been started”. At any point of time, you 
can quit the calibration process by clicking on the Abort button. 



Keysight M8131A 16/32 GSa/s Digitizer User’s Guide 77

M8131A User Interface 3

 

Saving and Loading Calibration

The calibration can be saved under the defined file name and location and 
can be later used for testing purpose. 

To save the calibration;

1 Click on the Save button. A standard Windows Save As dialog box will 
appear. 

Figure 21 Saving calibration

2 Specify the name (.TXT) and location

3 Click Save. 
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To load the calibration;

1 Click on the Load button. A standard Windows Open dialog box will 
appear. 

Figure 22 Loading calibration

2 Locate the calibration file (.TXT).

3 Click Open.
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Exporting Waveforms 

Waveforms can be exported to the available channels (channel 1/2/3/4). 

To save a waveform;

1 Go to File > Export Waveform and then select a channel. A standard 
Windows Save Waveform to File dialog box will appear. 

Figure 23 Exporting waveforms

2 Specify the name (.TXT) and location

3 Click Save. 
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Integrating 89600 VSA with M8131A

The M8131A Digitizer Soft Front Panel installer includes an integration 
with the Keysight 89600 VSA. To use the M8131 Digitizer with the 89600, 
the M8131 Digitizer SFP must be installed with the optional VSA 
integration on the same machine as the VSA.

The Keysight 89600 VSA connects to the M8131A Digitizer Soft Front 
Panel (SFP), either locally or remotely over LAN.

The M8131 VSA Extension requires Keysight 89600 VSA Version 2019 at 
the earliest.

While the Keysight 89600 VSA is in control of M8131A Digitizer, the user 
will be unable to make changes to the instrument directly via the SFP. The 
SFP shows a yellow banner indicating this. Changes to settings such as 
Decimation Rate or Center Frequency are made by the 89600 VSA 
software according to the requirements of configured measurements.

NOTE
The Hardware Sample Rate (dependent upon hardware and licensing 
options) chosen in the SFP is persistent through the 89600 connection to 
the SFP. To change the sample rate, first disconnect or close the 89600 
VSA software, then change the Hardware Sample Rate via the SFP.

NOTE
Reference Clock: The Reference Clock used by the M8131 Digitizer can 
be configured from within the 89600 VSA, via the menu 
Utilities->Frequency Reference. If the M8131 is configured with an 
external reference clock that it is unable to synchronize with, it will 
automatically revert to the internal (‘INT’) clock. To reconnect, the user 
will need to first change the setting back to the internal frequency 
reference, before connecting again to the external clock.
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Follow the given steps to configure M8131A with 89600 VSA:

1 Get the HiSLIP information

a Start the M8131A Soft Front Panel. 

b On the menu bar, click Help > About.

c Copy the HiSLIP information from the dialog.

NOTE
In the About box, the local HiSLIP address can be copied to the clip 
board with Ctrl+C, the remote address with Ctrl-R.

You can also right-click to open a context menu.
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2 Run Connection Expert

a Run the Keysight IO Libraries Suite Connection Expert tool.

b Click the Keysight IO Libraries Suite icon in the Windows 
application task bar, then click Connection Expert.

c Auto-scan/Rescan will automatically detect many (but not all) LAN 
instruments on your local LAN subnet. If an instrument is not 
automatically discovered, you must manually add the instrument:

d Click Add, select LAN Instrument from the context list. This opens 
the list of discovered LAN instruments. 

e Click the Enter Address tab.

f Enter the LAN address or hostname, select the protocol used to 
communicate with the instrument. 

g Click OK. 
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3 Integrate 89600 VSA with M8131A

a Start the 89600 VSA application.

b From the menu bar, click Utilities > Hardware > Configuration. The 
Hardware dialog box will appear.

c Click the  Refresh button in the Discovered Instruments tab. 
The M8131A should be now available.

d Click the Configurations tab and click the green plus sign . The 
New Hardware Configuration dialog box will appear:

e Select M8131 and click [>]

f Rename the configuration as per your choice and click OK.

g Select the new Analyzer Configuration (M8131A(1)) as shown in the 
following figure: 
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h The 89600 VSA will now acquire the M8131A.

i Close the Hardware dialog and start the measurement.
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This chapter provides an overview of data streaming over ODI.

The following table gives an overview about the different streaming 
modes:

Streaming Mode Name Required 
Options

Time Stamp Segmentation Deterministic 
Latency

Continuous -STR No No No

Continuous with deterministic 
latency

-STR No No Yes

Continuous Packetized VITA-49 -STR, -SEG Yes Yes No

Segmented Fixed VITA-49 -STR, -SEG Yes Yes No

Segmented Variable VITA-49 -STR, -SEG Yes Yes No
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The following table gives an overview about Trigger capabilities in the 
different streaming modes:

Streaming Mode Name Trigger 
Sweep Mode

Trigger 
Source

Allowed

Continuous Auto or Triggered Trigger Input or Channel n Yes

Continuous with deterministic latency Auto or Triggered Trigger Input or Channel n Yes

Continuous Packetized VITA-49 Auto or Triggered Trigger Input or Channel n Yes

Segmented Fixed VITA-49 Auto 

Triggered

Trigger Input or Channel n

Trigger Input or Channel n

No

Yes

Segmented Variable VITA-49 Auto 

Triggered

Trigger Input or Channel n

Input 
Channel n

No

No
Yes
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Continuous Streaming

Continuous streaming is typically used to stream data over ODI to a 
storage system such as a RAID or SSD.

Continuous streaming can also be used to steam data over ODI to a DSP 
module (e.g., the M8132A from Keysight) or an AWG (e.g., the M8121A 
from Keysight) if the overall latency through the system may vary from e.g., 
power cycle to power cycle. 

In case the latency through the system (M8131A Digitizer to M8132A DSP 
module to M8121A AWG) must be deterministic, do use Continuous 
Streaming with Deterministic Latency .

Cabling

For continuous streaming, the ODI cable must be connected from the 
M8131A (data source) to the data sink (storage system or DSP module or 
AWG). It’s not necessary to connect a cable to the Sync Output. 

Continuous streaming:

• Start of streaming: Both trigger conditions, triggered and auto are 
possible.

• The length of the data stream is infinite.

• Stop of streaming: By user.

Capture to waveform memory:

• While streaming is inactive, Start & Stop of capture is possible.

• Start: Both trigger conditions, triggered and auto are possible.

• Stop: By user or defined number of samples are captured. 

• While continuous streaming is active:

• It is possible to monitor the traffic that is streamed over the ODI 
port.

• Only capture without waiting for a trigger condition is possible (i.e., 
software start activity on the Trigger Input is ignored).

• Capture affects only one M8131A module and not multiple modules 
in a synchronous system.

• Mode: Single or repetitive.

NOTE
While capture to waveform memory is active, continuous streaming 
cannot be started.



88 Keysight M8131A 16/32 GSa/s Digitizer User’s Guide

4 Streaming
 

Continuous Streaming with Deterministic Latency

The M8131A can be initialized using SCPI commands to achieve a 
deterministic latency to Keysight instruments, for example, the M8121A 
AWG or M8132A DSP module.

Besides the M8131A digitizer, there must always be involved at least one 
additional instrument to achieve deterministic latency from the Data Input 
of the M8131A digitizer to the Data Output of the M8121A AWG or to the 
Trigger Output of the M8132A DSP module. An initialization process for all 
instruments in the chain must be performed to bring the instruments in 
deterministic latency mode. This initialization process is performed by 
sending SCPI commands to the instruments. Refer to the example 
program Continuous Streaming with Deterministic Latency to DSP Module 
on page 193.

The instruments must be connected according to following cabling 
instructions before running the deterministic latency initialization process.

After running the deterministic latency initialization process,

• The latency of a signal through the instruments is deterministic.

• The M8131A is in deterministic latency mode.

• All enabled data channels of the M8131A module are operating in 
deterministic latency mode.
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In deterministic latency mode:

• Streaming over ODI has started.

• It is possible to monitor the traffic that is streamed over the ODI port by 
capturing data.

• Only capture without waiting for a trigger condition is possible (i.e., 
software trigger is possible – activity on the Trigger Input is 
ignored).

• Capture affects only one module and not multiple modules in a 
synchronous system.

• Mode: Single or repetitive.

• Stop streaming leaves the deterministic latency mode.

When changing one of the following parameters, deterministic latency 
mode is left, and the initialization process must run again to enter 
deterministic latency mode.

• Change the decimation factors

• Change the sample rate (16GSa/s or 32 GSa/s)

• Change streaming mode from ‘Continuous’ to any other Streaming 
Mode.

• Stop streaming

• Disable ODI ports

• Disable or enable channels for data capture
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Segmented Streaming

Three options -STR, -SEG, DDC must be installed to enable segmented 
streaming. 

Segmented streaming is available in 16 GSa/s DDC mode.

Segmented streaming is not available in direct mode. 

Segmented streaming is not available in 32 GSa/s mode. 

When segmented streaming has been selected, all channels of the 
M8131A (or all channels of a synchronous systems of multiple M8131A) 
operate in segmented streaming mode. Also, the sub-streaming mode 
must be identical for all channels.

Triggers always drive all channels within one single M8131A module. For 
synchronous systems of multiple M8131A, only the primary module can be 
used to generate triggers.

Trigger on IF Magnitude: Triggers are applied to IQ data past DDC & 
decimation.

The following table explains the difference between segment and packet:

Streaming Mode Name Number of 
Packets per 
Segment

Comment

Continuous Packetized 
VITA-49

Variable The segment consists of a continuous 
stream of packets. Each packet is 
encapsulated in a VITA-49 header and 
trailer. 

Segmented Fixed VITA-49 1 Each segment always consists of one 
packet. This packet is encapsulated in a 
VITA-49 header and trailer. 

Segmented Variable VITA-49 Variable Each segment consists of a variable 
number of packets. The number is variable 
as each recorded segment length can be 
different. Segment recording starts when a 
trigger condition is valid, and the recording 
of this segment ends when an idle 
condition is detected. Each packet is 
encapsulated in a VITA-49 header and 
trailer.
The packet length defines the granularity 
of the segment length.
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VITA-49 Encoding

Each packet is always encapsulated in the VITA-49 data format, including 
a 28 bytes header and 4 bytes trailer. 

VITA-49 encoding of the M8131A is implemented according to ODI-2.1 
(High Speed Data Formats) Revision 3.0, January 3, 2019

The VITA-49 header includes time stamp information. The M8132A 
supports ‘UTC time plus picoseconds’ according to ODI-2.1 Figure 3-11 
(TSI=01; TSF=10) as the time stamp format.

Time Stamp Generation

The time stamp marks the beginning of the first sample of the 
corresponding packet. The time stamp does not mark the trigger position 
in the packet.

A time stamp is added to the header of each packet.

• The time stamp for each packet is encoded as VITA-49 header and 
streamed over ODI.

• For monitoring purposes, one waveform segment including the time 
stamp of its first packet can be stored in the waveform memory.

During the initialization of the M8131A, the controlling PC loads the local 
time of this PC to the M8131A in the UTC data format. After this 
initialization, the M8131A uses its internal timing reference to measure 
time and increment the internal clock, or it uses the timing reference 
applied to the Reference Clock Input pin.

The time stamp counter of the M8131A (UTC time) can be controlled by:

• SCPI API

• SFP

In a synchronous system consisting of two or more M8131A, the time 
stamp counters of each M8131A must be initialized individually.

There are three sub-modes available for segmented streaming:

• Continuous Packetized VITA-49. 

• Streaming is started once and runs continuously until aborted by the 
user. This continuous data stream is divided into individual VITA-49 
packets, each having an individual time stamp.

• The packet length can be adjusted.



92 Keysight M8131A 16/32 GSa/s Digitizer User’s Guide

4 Streaming
 

• Segmented Fixed VITA-49. 

• This mechanism is a very effective way for data compression for 
bursted RF traffic or radar pulse recording. This mode is best suited, 
if the segment length is always the same.

• Streaming of each segment requires an individual trigger condition. 
If the defined trigger condition is met, exactly one segment of a 
pre-defined segment length is streamed over ODI. No data is 
streamed over ODI until the next trigger condition starts streaming 
the next segment. 

• The number of segments that are streamed can be between 
1…232-1 and infinite.

• The packet length can be adjusted.

• Segmented Variable VITA-49. 

• This mode is best suited, if the segment length varies from segment 
to segment. E.g., radar pulses generated from multiple uncorrelated 
sources generate this type of traffic.

• Each segment consists of a variable number of packets. Each packet 
is encapsulated in VITA-40 header and trailer.

• Streaming of each segment requires an individual trigger condition. 
If the defined trigger condition is met, the streaming of packets of 
over ODI is started. Streaming of packets ends when the trigger 
condition is not met anymore, and an idle condition has been 
detected. As a result, a segment of a variable length, each 
consisting of a variable number of packets can be recorded. This 
mechanism is a very effective way for data compression for bursted 
RF traffic or radar pulse recording.

• The number of segments that are streamed can be between 
1…232-1 and infinite.

• The packet length defines the granularity of a segment with variable 
length. The packet length can be adjusted.

• The end of capturing a segment of variable length is determined by 
detecting an idle period the exceeds a user-defined duration. Idle is 
defined as:

• Rising edge, IF magnitude: The IF magnitude is below the IF 
magnitude for the idle duration or longer.

• Falling edge, IF magnitude: The IF magnitude is above the IF 
magnitude for the idle duration or longer.
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In all three sub-modes of segmented streaming (Continuous Packetized 
VITA-49, Segmented Fixed VITA-49, Segmented Variable VITA-49) it is 
possible to monitor the traffic that is streamed over the ODI port.

• Only capture without waiting for a trigger condition is possible (i.e., 
software start –activity on the Trigger Input is ignored).

• Exactly one segment of fixed or variable length including time stamp 
information is stored in capture memory.

• Capture affects only one M8131A module and not multiple modules in 
a synchronous system.

• Mode: Single or repetitive.

The following figure describes the differences between the streaming 
modes Continuous Packetized VITA-49, Segmented Fixed VITA-49, and 
Segmented Variable VITA-49.
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Instrument Modes Supporting Synchronization

The following table shows M8131A modes of operation that support the 
synchronization of multiple M8131A.

ADC Sample Rate DDC Decimation factor Synchronization 
Supported

16 GSa/s Off 1, 2, 4 Yes

16 GSa/s On 4, 8, …, 512 No

32 GSa/s Off 1, 2, 4 Yes

32 GSa/s On 4, 8, …, 512 No
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Cabling Instructions

Synchronization of two M8131A modules

The following figure displays the synchronization of two M8131A modules 
in a 5-slot chassis.

The synchronization of two M8131A modules results in eight channels at 
16 GSa/s or four channels at 32 GSa/s.

One-time instrument-to-instrument de-skew is required to compensate 
for the cable length variations. This process is described below.

After de-skew, the channel-to-channel skew across all eight channels at 
16GSa/s (or four channels at 32 GSa/s) is:

• within <0.5 ps from capture to capture*

• within +/-1 ps from power cycle to power cycle*

* Constant ambient temperature
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Synchronization of three M8131A modules

The following figure displays the synchronization of three M8131A 
modules (two M8131A modules in a 5-slot chassis + one M8131A module 
in a 2-slot chassis).

The synchronization of three M8131A modules result in 12 channels at 16 
GSa/s or six channels at 32 GSa/s.

One-time instrument-to-instrument de-skew is required to compensate 
for the cable length variations. This process is described below.

After de-skew, the channel-to-channel skew across all 12 channels at 
16GSa/s (or six channels at 32 GSa/s) is:

• within <0.5 ps from capture to capture*

• within +/-1 ps from power cycle to power cycle*

* Constant ambient temperature
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Synchronization of four M8131A modules

The following figure displays the synchronization of four M8131A modules 
(two M8131A modules in one 5 slot chassis + two M8131A modules in one 
5-slot chassis).
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The synchronization of four M8131A modules result in 16 channels at 16 
GSa/s or eight channels at 32 GSa/s.

One-time instrument-to-instrument de-skew is required to compensate 
for the cable length variations. This process is described below.

After de-skew, the channel-to-channel skew across all 16 channels at 
16GSa/s (or eight channels at 32 GSa/s) is:

• within <0.5 ps from capture to capture*

• within +/-1 ps from power cycle to power cycle*

* Constant ambient temperature
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One-time Instrument-to-Instrument De-skew

• The timing skew between different M8131A modules depends on the 
length of the electrical cables used for Sample Clock and Sync Signal 
distribution. To minimize this skew, it is recommended to use the 
following:

• Cables for Sample Clock distribution of the same length having the 
same propagation delay. Also, the same type of power splitter 
should be used.

• Cables for Synch Signal distribution of the same length having the 
same propagation delay.

• To characterize the remaining skew, an external signal must be applied 
to channel 1 of the synchronous system's different M8131A. There is 
flexibility in the external signal type, for example, the rising edge of a 
rectangular signal. This signal shall be distributed using a power 
splitter to both channel 1 of two M8131A. One measures the skew 
between the two signals using the SFP. This measured skew value can 
be used to correct the delay when reading the different digitizers' 
timing information.

• In case three or four digitizers are within the synchronous system, the 
skew must be measured between the different digitizers.

• This configuration can be characterized by connecting the two cables 
to channel one and channel two of the same digitizer to compensate 
for an error caused by the external power splitter and their cables.
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Synchronization Procedure

• To synchronize multiple M8131A modules, a synchronization
procedure must be executed. For more information on how to execute
the synchronization, refer to Synchronization of Two M8131A Modules
on page 190.

• The synchronization between the M8131A gets lost, and the
synchronization procedure must be executed after the following
events:

• Power cycles

• Execution of *RST

• Change of the sample rate between 16GSa/s and 32GSa/s

• Change the decimation factor in direct mode
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6 Digital Down 
Conversion

Option -DDC must be installed to enable Digital Down Conversion.

Each analog channel has a separate DDC. The IF frequency can be 
adjusted for each channel separately. The decimation factor is the same 
for all channels in the M8131A.

Spectrum mirroring: Negative IF frequencies can be adjusted. This results 
in a mirrored spectrum of the down-converted data.

The data format in DDC mode is 32-bit IQ. This is 16-bit I plus 16-bit Q.

The following table gives an overview of the DDC modes with an ADC 
sample rate of 32 GSa/s. Following M8131A product options offer an ADC 
sample rate of 32 GSa/s: -131, -132, -FD1, -FD2, -FD4. 6}

1 In 32 GSa/s mode, 2 ODI links per ADC channel are required.

Decimation factor Sample rate after 
decimation

Data rate over ODI Modulation 
bandwidth

4 8 GSa/s 256 Gbit/s 6.4 GHz

8 4 GSa/s 128 Gbit/s 3.2 GHz

16 2 GSa/s 64 Gbit/s 1.6 GHz

32 1 GSa/s 32 Gbit/s 800 MHz

64 500 MSa/s 16 Gbit/s 400 MHz

128 250 MSa/s 8 Gbit/s 200 MHz

256 125 MSa/s 4 Gbit/s 100 MHz

512 62.5 MSa/s 2 Gbit/s 50 MHz
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6 Digital Down Conversion

The following table gives an overview of the modes of the DDC with an 
ADC sample rate of 16 GSa/s. Following M8131A product options offer an 
ADC sample rate of 16 GSa/s: -061, -062, -064, -FD1, -FD2, -FD4.

The DDC functionality for M8131A product options -011, -012, -014 is 
shown in the following table. For these product options, the ADC sample 
rate is 16 GSa/s. The minimum decimation factor is 8 resulting in a 
maximum modulation bandwidth of 1.6 GHz.

Decimation factor Sample rate after 
decimation

Data rate over ODI Modulation 
bandwidth

4 4 GSa/s 128 Gbit/s 3.2 GHz

8 2 GSa/s 64 Gbit/s 1.6 GHz

16 1 GSa/s 32 Gbit/s 800 MHz

32 500 MSa/s 16 Gbit/s 400 MHz

64 250 MSa/s 8 Gbit/s 200 MHz

128 125 MSa/s 4 Gbit/s 100 MHz

256 62.5 MSa/s 2 Gbit/s 50 MHz

512 31.25 MSa/s 1 Gbit/s 25 MHz

Decimation factor Sample rate after 
decimation

Data rate over ODI Modulation 
bandwidth

8 2 GSa/s 64 Gbit/s 1.6 GHz

16 1 GSa/s 32 Gbit/s 800 MHz

32 500 MSa/s 16 Gbit/s 400 MHz

64 250 MSa/s 8 Gbit/s 200 MHz

128 125 MSa/s 4 Gbit/s 100 MHz

256 62.5 MSa/s 2 Gbit/s 50 MHz

512 31.25 MSa/s 1 Gbit/s 25 MHz
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Remote Programming Overview

This chapter introduces the basics for remote programming of an M8131A 
instrument using SCPI commands.

Instructions

Instructions, both commands and queries, normally appear as strings 
embedded in a statement of your host language, such as Visual Basic for 
Applications (VBA), Visual Basic .NET, C#, C, etc.

The only time a parameter is not meant to be expressed as a string is when 
the instruction's syntax definition specifies <binary_block _data>, such as 
with the :SYSTem:SET command. There are only a few instructions that 
use block data.

Instructions are composed of two main parts:

• The header, which specifies the command or query to be sent.

• The program data, which provides additional information to clarify the 
meaning of the instruction.

Instruction Header

The instruction header is one or more command mnemonics separated by 
colons (:). They represent the operation to be performed by the instrument. 
Queries are formed by adding a question mark (?) to the end of the header. 
Many instructions can be used as either commands or queries, depending 
on whether or not you include the question mark. The command and query 
forms of an instruction usually have different program data. Many queries 
do not use any program data.

White Space (Separator)

White space is used to separate the instruction header from the program 
data. If the instruction does not require any program data parameters, you 
do not need to include any white space. In this manual, white space is 
defined as one or more spaces. ASCII defines a space to be character 32 in 
decimal.
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Braces

When several items are enclosed by braces, { }, only one of these elements 
may be selected. Vertical line ( | ) indicates "or". For example, {ON | OFF} 
indicates that only ON or OFF may be selected, not both.

Ellipsis

... An ellipsis (trailing dots) indicates that the preceding element may be 
repeated one or more times.

Square Brackets

Items enclosed in square brackets, [ ], are optional.

Program Data

Program data is used to clarify the meaning of the command or query. It 
provides necessary information, such as whether a function should be on 
or off, or which waveform is to be displayed. Each instruction's syntax 
definition shows the program data and the values they accept.

When there is more than one data parameter, they are separated by 
commas (,). You can add spaces around the commas to improve 
readability.
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Status Commands

This section describes the structure of the SCPI status system used by the 
M8131A. The status system records various conditions and states of the 
instrument in several register groups as shown on the following pages. 
Each of the register groups is made up of several low level registers called 
Condition registers, Event registers, and Enable registers which control the 
action of specific bits within the register group.

These groups are explained below:

A condition register continuously monitors the state of the instrument. The 
bits in the condition register are updated in real time and the bits are not 
latched or buffered. This is a read-only register and bits are not cleared 
when you read the register. A query of a condition register returns a 
decimal value which corresponds to the binary-weighted sum of all bits set 
in that register.

An event register latches the various events from changes in the condition 
register. There is no buffering in this register; while an event bit is set, 
subsequent events corresponding to that bit are ignored. This is a read 
only register. Once a bit is set, it remains set until cleared by query 
command (such as STAT:QUES:EVEN?) or a *CLS (clear status) 
command. A query of this register returns a decimal value which 
corresponds to the binary-weighted sum of all bits set in that register.

An enable register defines which bits in the event register will be reported 
to the Status Byte register group. You can write to or read from an enable 
register. A *CLS (clear status) command will not clear the enable register 
but it does clear all bits in the event register. A STAT:PRES command 
clears all bits in the enable register. To enable bits in the enable register to 
be reported to the Status Byte register, you must write a decimal value 
which corresponds to the binary weighted sum of the corresponding bits.

Transition Filters are used to detect changes of the state in the condition 
register and set the corresponding bit in the event register. You can set 
transition filter bits to detect positive transitions (PTR), negative transitions 
(NTR) or both. Transition filters are read/write registers. They are not 
affected by *CLS.
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Figure 24 Status register structure
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STATus:PRESet

Clears all status group event registers. Presets the status group enables 
PTR and NTR registers as follows:

ENABle = 0x0000, PTR = 0xffff, NTR = 0x0000

Status Byte Register

The Status Byte summary register reports conditions from the other status 
registers. Data that is waiting in the instrument’s output buffer is 
immediately reported on the “Message Available” bit (bit 4) for example. 
Clearing an event register from one of the other register groups will clear 
the corresponding bits in the Status Byte condition register. Reading all 
messages from the output buffer, including any pending queries, will clear 
the “Message Available” bit. To set the enable register mask and generate 
an SRQ (service request), you must write a decimal value to the register 
using the *SRE command.

Table 6  Status byte register

Bit Number Decimal Value Definition

0 Not used 1 Not Used. Returns “0”

1 Not used 2 Not Used. Returns “0”

2 Error Queue 4 One or more errors are stored in the Error Queue

3 Questionable Data 8 One or more bits are set in the Questionable Data 
Register (bits must be enabled)

4 Message Available 16 Data is available in the instrument’s output buffer

5 Standard Event 32 One or more bits are set in the Standard Event Register

6 Master Summary 64 One or more bits are set in the Status Byte Register

7 Operational Data 128 One or more bits set in the Operation Data Register (bits 
must be enabled)
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Questionable Data Register Command Subsystem

The Questionable Data register group provides information about the 
quality or integrity of the instrument. Any or all of these conditions can be 
reported to the Questionable Data summary bit through the enable 
register.

Table 7  Questionable data register

Bit Number Decimal Value Definition

0 Not used 1 Returns “0”

1 Not used 2 Returns “0”

2 Not used 4 Returns “0”

3 Not used 8 Returns “0”

4 Not used 16 Returns “0”

5 Reference Clock Status 32 Instable or missing external reference clock.

6 Not used 64 Returns “0”

7 USB disconnected 128 USB module connection state 

8 Sample Clock Status 256 Instable or missing sample clock

9 Filter Status 512 Filter input overload or output clipped for at least 
one channel

10 ADC Calibration Status 1024 For more details, see ADC Calibration 
Status Subsystem on page 114.

11 Not used 2048 Returns “0”

12 Not used 4096 Returns “0”

13 Not used 8192 Returns “0”

14 Not used 16384 Returns “0”

15 Not used 32768 Returns “0”
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Operation Status Subsystem

The Operation Status register contains conditions which are part of the 
instrument’s normal operation.

Table 8  Operation status register

Bit Number Decimal Value Definition

0 Not used 1 Returns “0”

1 Not used 2 Returns “0”

2 Not used 4 Returns “0”

3 Not used 8 Returns “0”

4 Arm Status 16 Trigger is armed.

5 Trigger Status 32 Trigger received.

6 Streaming Active 64 Data streaming has been started and not 
stopped yet.

7 Memory Capture in Progress 128 Memory capture has been started and not 
completed yet. 

8 Not used 256 Returns “0”

9 Not used 512 Returns “0”

10 ADC Calibration Run Status 1024 ADC calibration is running.

11 Not used 2048 Returns “0”

12 Not used 4096 Returns “0”

13 Not used 8192 Returns “0”

14 Not used 16384 Returns “0”

15 Not used 32768 Returns “0”
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Reference Clock Status Subsystem

The Reference Clock Status register contains information about the 
validity of the 10 or 100 MHz external reference clock of the module.

The following SCPI commands and queries are supported:

:STATus:QUEStionable:REFClock[:EVENt]?
:STATus:QUEStionable:REFClock:CONDition? 
:STATus:QUEStionable:REFClock:ENABle[?] 
:STATus:QUEStionable:REFClock:NTRansition[?] 
:STATus:QUEStionable:REFClock:PTRansition[?] 

Table 9  Reference clock status register

Connection Status Subsystem

The Connection Status register contains the state of the USB connection 
to the M8131A module.

The following SCPI commands and queries are supported:

:STATus:QUEStionable:CONNection[:EVENt]?
:STATus:QUEStionable:CONNection:CONDition? 
:STATus:QUEStionable:CONNection:ENABle[?] 
:STATus:QUEStionable:CONNection:NTRansition[?] 
:STATus:QUEStionable:CONNection:PTRansition[?]

Bit Number Decimal Value Definition

0 Amplitude too small 1 Amplitude of external reference signal too small.

1 Amplitude too big 2 Amplitude of external reference signal too big.

2 Frequency out-of-range 4 Frequency of external reference signal out-of-range.
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Table 10  Connection status register

ADC Calibration Status Subsystem

The following SCPI commands and queries are supported:

:STATus:QUEStionable:CALibration:ADC[:EVENt]?
:STATus:QUEStionable:CALibration:ADC:CONDition? 
:STATus:QUEStionable:CALibration:ADC:ENABle[?] 
:STATus:QUEStionable:CALibration:ADC:NTRansition[?] 
:STATus:QUEStionable:CALibration:ADC:PTRansition[?] 

Table 11  ADC calibration status register

Bit Number Decimal Value Definition

0 USB disconnected 1 USB module connection state

Bit Number Decimal Value Definition

0 Calibration data invalid 1 ADC calibration data is invalid.

1 Calibration necessary 2 ADC re-calibration is necessary.

2 Calibration not finished 
successfully.

4 Cleared after a successful calibration.

3 Calibration aborted 8 ADC calibration was aborted by the user.

4 Calibration failed 16 ADC calibration failed.

NOTE
Upon software start, bit 2 is set and bits 3, 4 are cleared. When a 
calibration was run, the bits are updated accordingly.
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Filter Status Subsystem

The Filter Status register contains the frequency response correction filter 
input overload and output clipped status per channel.

The following SCPI commands and queries are supported:

:STATus:QUEStionable:FILTer[:EVENt]?
:STATus:QUEStionable:FILTer:CONDition?
:STATus:QUEStionable:FILTer:ENABle[?]
:STATus:QUEStionable:FILTer:NTRansition[?]
:STATus:QUEStionable:FILTer:PTRansition[?]

Table 12  Filter status register

Bit Number Decimal Value Definition

0 Channel 1 Filter input overload 1 A sample with a minimum or maximum possible 
ADC code (-511 or +511, respectively) was detected 
at the filter input.1 Channel 2 Filter input overload 2

2 Channel 3 Filter input overload 4

3 Channel 4 Filter input overload 8

4 Channel 1 Filter output clipped 16 A sample with an ADC code outside the valid range 
of -511 to +511 was detected after filtering at the 
filter output5 Channel 2 Filter output clipped 32

6 Channel 3 Filter output clipped 64

7 Channel 4 Filter output clipped 128
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Sample Clock Status Subsystem

The Sample Clock Status register contains the status of the 8 GHz clock 
signal connected to the Sample Clk In.

The following SCPI commands and queries are supported:

:STATus:QUEStionable:SCLock[:EVENt]?
:STATus:QUEStionable:SCLock:CONDition?
:STATus:QUEStionable:SCLock:ENABle[?]
:STATus:QUEStionable:SCLock:NTRansition[?]
:STATus:QUEStionable:SCLock:PTRansition[?]

Table 13  Sample clock status register

Bit Number Decimal Value Definition

0 Sample Clock invalid 1 No sample clock signal is connected to Sample Clk 
In, or the connected sample clock is invalid and 
cannot be used, because its amplitude or frequency 
is out-of-range.
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ADC Calibration Run Status Subsystem

The following SCPI commands and queries are supported:

:STATus:OPERation:CALibration:ADC[:EVENt]?
:STATus:OPERation:CALibration:ADC:CONDition? 
:STATus:OPERation:CALibration:ADC:ENABle[?] 
:STATus:OPERation:CALibration:ADC:NTRansition[?] 
:STATus:OPERation:CALibration:ADC:PTRansition[?]

Table 14  Run status register

Bit Number Decimal Value Definition

0 Calibration Run Status 1 Indicates that an ADC calibration is running 

1 Calibration Step Running 2 Indicates that an ADC calibration step is running

NOTE
In modules with differential inputs, only bit 0 is important. It is set while 
the calibration is active and is cleared when the calibration is finished.

In modules with single ended inputs, where an external N2136A 
calibration module must be connected for the calibration, this is 
different. These modules are calibrated channel by channel and for each 
step the calibration module must be connected to the next channel. 

Bit 0 is set when the calibration for the first channel is started and 
cleared when calibration for the last channel is finished.

Bit 1 is set while the calibration for a single channel is running. A ‘0’ 
indicates that the calibration module can be connected to the next 
channel and the :CALibrate:ADC:NEXT SCPI command can be issued 
again.
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Arm Status Subsystem

The following SCPI commands and queries are supported:

:STATus:OPERation:ARMed[:EVENt]?
:STATus:OPERation:ARMed:CONDition?
:STATus:OPERation:ARMed:ENABle[?]
:STATus:OPERation:ARMed:NTRansition[?]
:STATus:OPERation:ARMed:PTRansition[?]
Table 15  Arm status register

Trigger Status Subsystem

The following SCPI commands and queries are supported:

:STATus:OPERation:TRIGgered[:EVENt]?
:STATus:OPERation:TRIGgered:CONDition?
:STATus:OPERation:TRIGgered:ENABle[?]
:STATus:OPERation:TRIGgered:NTRansition[?]
:STATus:OPERation:TRIGgered:PTRansition[?]
Table 16  Trigger status register

Bit Number Decimal Value Definition

0 Trigger Arm 1 The trigger system is armed and waiting for a 
trigger.

Bit Number Decimal Value Definition

0 Trigger Status 1 A trigger was detected.
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Memory Capture Status Subsystem

The following SCPI commands and queries are supported:

:STATus:OPERation:MEMCapture[:EVENt]?
:STATus:OPERation:MEMCapture:CONDition?
:STATus:OPERation:MEMCapture:ENABle[?]
:STATus:OPERation:MEMCapture:NTRansition[?]
:STATus:OPERation:MEMCapture:PTRansition[?]
Table 17  Memory Capture status register

Data Streaming Status Subsystem

The following SCPI commands and queries are supported:

:STATus:OPERation:STReam[:EVENt]?
:STATus:OPERation:STReam:CONDition?
:STATus:OPERation:STReam:ENABle[?]
:STATus:OPERation:STReam:NTRansition[?]
:STATus:OPERation:STReam:PTRansition[?]
Table 18  Data Streaming status register

Bit Number Decimal Value Definition

0 Memory Capture in 
Progress

1 Memory capture has been started and not 
completed yet.

Bit Number Decimal Value Definition

0 Data Streaming in 
Progress

1 Data streaming has been started and not stopped 
yet.
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ODI Time Output Sync Status Subsystem

The following SCPI commands and queries are supported:

:STATus:OPERation:TOSync[:EVENt]?
:STATus:OPERation:TOSync:CONDition?
:STATus:OPERation:TOSync:ENABle[?]
:STATus:OPERation:TOSync:NTRansition[?]
:STATus:OPERation:TOSync:PTRansition[?]
Table 19  Time Output Sync status register

Bit Number Decimal Value Definition

0 Time Sync in Progress 1 Time Sync procedure is started but not complete.

1 Time Sync in Progress 2 Time is synchronized
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Acquire Commands

The ACQuire subsystem commands set up conditions for executing a 
:DIGitize, :DIGitize:NDISplay or :RUN root level command to acquire 
waveform data into capture memory or a :STReam root level command to 
stream waveform data out of the ODI links. The commands in this 
subsystem select the sampling frequency and the number of data points.

:ACQuire: SRATe[?]

Command :ACQuire:SRATe {S16G | S32G}
The command sets the acquisition sampling rate.

S16G 16GSa/s

S32G 32GSa/s

Query :ACQuire:SRATe?
The query returns the acquisition sampling rate.

Example Command
:ACQuire:SRATe S16G

:ACQuire:POINts[?]

Command :ACQuire:POINts <points_value>
The command sets the requested memory depth for an acquisition into 
capture memory.

<points_value> An integer representing the memory depth per 
channel. When raw data is captured, the value denotes the number of 
samples. When IQ data is captured, the value denotes the number of IQ 
sample pairs.

The minimum and maximum values and the granularity of the points 
available for a channel depend on the sampling rate, the data processing 
mode (Direct/DDC) and the decimation factor. If the passed parameter 
does not fulfill the granularity the value is adjusted to the next higher 
supported value.
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The query returns the value of the memory depth.

Returned Format [:ACQuire:POINts] <points_value><NL>

:ACQuire:SEGMented:PCOunt[?]

Command :ACQuire:SEGmented:PCOunt <number of packets to 
stream>
This command sets the total number of packets that will be streamed 
(unless “infinite” is specified). 

Query :ACQuire:SEGMented:PCOunt?
This query returns the total number of packets that will be streamed 
(unless “infinite” is specified).

Example Command
:ACQuire:SEGmented:PCOunt 10

Sample Rate 16 GSa/s Minimum Maximum Granularity

Direct, No Decimation 400 419430400 400

Direct, Decimation by 2 64 268435456 64

Direct, Decimation by 4 64 268435456 64

DDC 32 134217728 32

Sample Rate 32 GSa/s Minimum Maximum Granularity

Direct, No Decimation 800 838860800 800

Direct, Decimation by 2 128 536870912 128

Direct, Decimation by 4 128 536870912 128

DDC 64 268435456 64
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:ACQuire:SEGMented: PCOunt:INFinite[?]

Command :ACQuire:SEGMented:PCOunt:INFinite <value>
This command sets the number of packets in segmented mode to the 
maximum possible value.

Query :ACQuire:SEGMented:PCOunt:INFinite?
This query returns whether the number of packets available is infinite or 
not.

Example Command
:ACQuire:SEGMented:PCOunt:INF 1

:ACQuire:SEGMented:PLENgth[?]

Command :ACQuire:SEGMented:PLENgth <samples>
This command sets the length of one packet in segmented or continuous 
packetized mode. When a capture is taken while streaming is active, the 
amount of captured data depends on the streaming mode:

Continuous: The capture is independent of streaming.

Continuous Packetized: One packet is captured

Segmented Fixed: One segment (= one packet) is captured.

Segmented Variable: One segment (= a number of contiguous packets, up 
to memory size) is captured.

Query :ACQuire:SEGMented:PLENgth?
The query returns the length of one packet in segmented or continuous 
packetized mode. 
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:ACQuire:STReaming:MODE

Command :ACQuire:STReaming:MODE {CONTinuous | CPACketized| 
SFIXed | SVARiable}
The command sets the streaming mode. There are four streaming modes 
available: 

Continuous, Continuous Packetized VITA-49, Segmented Fixed VITA-49 
and, Segmented Variable VITA-49. For more information about each 
mode, refer to Streaming and Segmentation on page 85.

Query :ACQuire:STReaming:MODE?
The query returns the streaming mode.

:ACQuire:TSTamp

Command :ACQuire:TSTamp
The command sets the time stamp when a capture has been started.

Query :ACQuire:TSTamp?
This query returns a list of three commas separated uint32 values in the 
order of appearance, seconds, the high fraction of picoseconds, and the 
low fraction of picoseconds.

Example :ACQ:TST?
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ADC Calibration Commands

The CALibration subsystem contains commands to re-calibrate the ADC of 
the digitizer and to calibrate the deterministic latency in the data path to 
another module.

ADC Calibration Commands

The ADC calibration commands allow to re-calibrate the ADC of the 
digitizer, to query the calibration status and to save and load calibration 
data.

:CALibrate:ADC[:STARt]

Command :CALibrate:ADC[:STARt]
Description The command starts the self-calibration of the ADC module.

:CALibrate:ADC:NEXT

Command :CALibrate:ADC:NEXT
Description The command starts the next step of the ADC module’s self-calibration.

:CALibrate:ADC:ABORt

Command :CALibrate:ADC:ABORt
Description The command aborts a running self-calibration of the ADC module.

NOTE
In modules with single ended inputs, where a calibration requires an 
external calibration module, this command starts the calibration of the 
first channel.

NOTE
This command applies only to the modules with single ended inputs, 
where a calibration requires an external calibration module.
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:CALibrate:ADC:INFormation?

Query :CALibrate:ADC:INFormation?
Description The query returns information about the last calibration of the ADC 

module.

Returned Format [:CALibrate:ADC:INFormation] <information_string><NL>
<information_string> Contains information about type (“User” or 
“Factory”) and date of last calibration.

Example Query

:CALibrate:ADC:INFormation?
“M8131A Setup:
Mode: 16GHz on 4 channels
Calibration Loaded:
1(User): 2018-03-09 17:33:44”

:CALibrate:ADC:RECommended?

Query :CALibrate:ADC:RECommended?
Parameters None
Description This query returns a Boolean value, indicating if an ADC calibration is 

recommended.

Return Format [:CALibrate:ADC:RECommended] <recommended><NL>
Example :CAL:ADC:REC?  0

:CALibrate:ADC:DATE[:RECommended]?

Query :CALibrate:ADC:DATE[:RECommended]?
Parameters None
Description This query returns the date when the next ADC calibration is 

recommended.

Return Format [:CALibrate:ADC:DATE:RECommended] <date><NL>
Example :CAL:ADC:DATE?  “2020-07-01”
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:CALibrate:ADC:TEMPerature:DELTa[:CURRent]?

Query :CALibrate:ADC:TEMPerature:DELTa[:CURRent]?
Parameters None
Description This query returns the ADC temperature difference to the last ADC 

calibration.

Return Format [:CALibrate:ADC:TEMPerature:DELTa[:CURRent]] 
<temperature difference><NL>

Example :CAL:ADC:TEMP:DELT?  1.00000000000000E+00

:CALibrate:ADC:TEMPerature:DELTa:MAXimum?

Query :CALibrate:ADC:TEMPerature:DELTa:MAXimum?
Parameters None
Description This query returns the maximum ADC temperature difference to the last 

ADC calibration before a new calibration is recommenced.

Return Format [:CALibrate:ADC:TEMPerature:DELTa:MAXimum?] <max 
temperature difference><NL>

Example :CAL:ADC:TEMP:DELT?  1.00000000000000E+01

:CALibrate:ADC:TEMPerature:DELTa:MINimum?

Query :CALibrate:ADC:TEMPerature:DELTa:MINimum?
Parameters None
Description This query returns the minimum ADC temperature difference to the last 

ADC calibration before a new calibration is recommenced.

Return Format [:CALibrate:ADC:TEMPerature:DELTa:MAXimum?] <min 
temperature difference><NL>

Example :CAL:ADC:TEMP:DELT?  -1.00000000000000E+01
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:CALibrate:ADC:SAVE

Command :CALibrate:ADC:SAVE <file_name>
Description The command saves the calibration data of the ADC module to a file.

<file_name> A quoted ASCII string with a maximum of 254 characters 
including the entire path name, if used. The filename assumes the present 
working directory, if a path does not precede the file name.

:CALibrate:ADC:LOAD

Command :CALibrate:ADC:LOAD <file_name>
Description The command loads the calibration data of the ADC module from a file.

<file_name> A quoted ASCII string with a maximum of 254 characters 
including the entire path name, if used. The filename assumes the present 
working directory, if a path does not precede the file name.
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Latency Calibration Commands

The Latency Calibration commands are used to initialize the deterministic 
latency in the data path between the M8131A digitizer and another 
module connected via ODI links, for example a DSP or an AWG.

The digitizer, as the module connected upstream in the data path, will be 
referred to as the primary module in the command description. The 
module connected downstream in the data path will be referred to as the 
secondary module. For deterministic latency initialization, a defined 
sequence of commands must be sent to the primary and secondary 
module. Refer to Continuous Streaming with Deterministic Latency to DSP 
Module on page 193.

The Latency Calibration commands are also used to initialize the Sync Out 
to Sync In connection of multiple M8131A digitizer modules operating as a 
synchronous system. The digitizer sending out trigger pulses on Sync Out 
will be referred to as the primary module in the command description. The 
modules receiving trigger pulses on Sync In will be referred to as 
secondary module. For the initialization of a synchronous system, a 
defined sequence of commands must be sent to the primary and 
secondary module. Refer to Synchronization of Two M8131A Modules on 
page 190.

:CALibrate:SYNC:INPut:LEVel

Command :CALibrate:SYNC:INPut:LEVel <level>
Description This command sets the threshold level of the Sync In. The threshold level is 

set by default to the optimum voltage level to match the output voltage 
range of the Sync Out of the M8131A or M8132A. Do not change the Sync 
In threshold when connected to a Sync Out of the M8131A or M8132A.

<level> The threshold level in V.

Query :CALibrate:SYNC:INPut:LEVel?
Description This query returns the current threshold level of the Sync In.

:CALibrate:LATency:LCMPeriod

Command :CALibrate:LATency:LCMPeriod <lcm_period>
Description This command sets the Least Common Multiple (LCM) period value to be 

used for core clock phase alignment. On the primary module, this value 
determines the frequency of the signal sent out at the Sync Out. On the 
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secondary module, this value determines the frequency of the signal used 
to compare with the signal received at the Sync In. The formula for the 
frequency is:

f = 400MHz / LCM period.

<lcm_period> The LCM period as an even integer between 2 and 32768.

Query :CALibrate:LATency:LCMPeriod?
Description This query returns the current LCM period.

:CALibrate:LATency:MODE

Command :CALibrate:LATency:MODE {SEParate | COMBined}
Description This command selects the latency calibration mode.

• SEParate – Phase alignment to the primary module’s core clock and 
latency calibration are separate steps. This mode is used for latency 
setup between M8131A and M8132A DSP.

• COMBined - Phase alignment to the primary module’s core clock and 
latency calibration are done in the same step. This mode is used for 
latency setup between M8131A and M8121A AWG.

Query :CALibrate:LATency:MODE?
Description This query returns the current latency calibration mode.

:CALibrate:LATency[:STEP]

Command :CALibrate:LATency[:STEP] {GSYNc | ALIGnphase | SSYNc
| ARMadjust | PREPare}

Description This command executes a step in the latency calibration of the data path 
between the primary and secondary module. As mentioned in brackets, 
some commands are sent to and affect only the primary module and some 
only the secondary module. It is indicated as well, when commands are 
relevant only for one calibration mode (SEParate, COMBined).

• GSYNc - Generate clock signal at Sync Out (primary module, 
SEParate).

• ALIGnphase - Use the clock signal received at Sync In to align the 
phase of the core clock (secondary module).

• SSYNc - Stop the clock signal generation at Sync Out (primary 
module).
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• ARMadjust - Arm the module for latency adjustment (secondary 
module). When the primary module starts sending data over the ODI, 
the latency is measured in the secondary module and the FIFOs are 
adjusted accordingly.

• PREPare - Set the Sync Out to pulse mode (primary module, SEParate). 
When data streaming is started, a single pulse is sent at the Sync Out.

:CALibrate:LATency:CKSYnc:OFFSet[?]

Command :CALibrate:LATency:CKSYnc:OFFSet <value>
Description This command sets the offset value of the sync clock. 

Query :CALibrate:LATency:CKSYnc:OFFSet?
Description This query returns the current offset value of the sync clock.

:CALibrate:LATency:SPDelay

Command :CALibrate:LATency:SPDelay {A|B}, <sync_pulse_delay>
Description This command sets the synchronization pulse delay for the selected FPGA 

in multiples of the core clock period (5ns).

A Selects FPGA A.

B Selects FPGA B.

<sync_pulse_delay> The synchronization pulse delay as an unsigned 
integer between 0 and 1023.

Query :CALibrate:LATency:SPDelay? {A|B}
Description This query returns the synchronization pulse delay for the selected FPGA.
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Channel Commands

The CHANnel subsystem contains commands and queries for the 
following:

• Selection of channels for memory capture.

• Configuration of voltage range and offset for digitizer modules with 
single-ended inputs

• Configuration of Digital-Down-Conversion (DDC), if the option -DDC is 
installed.

• Configuration of the correction filter.

:CHANnel<N>:DISPlay

Command :CHANnel<N>:DISPlay {{ON | 1} | {OFF | 0}}
Description The command selects or deselects a channel for waveform data capture to 

memory. Additionally, it turns the data display of the specified channel on 
or off.

<N> An integer, 1-4

Query :CHANnel<N>:DISPlay?
The query returns the current display condition for the specified channel.

Returned Format [:CHANnel<N>:DISPlay] {1 | 0}<NL>

:CHANnel<N>:OFFSet

Command :CHANnel<N>:OFFSet <offset>
Description The command sets the voltage value that is represented at the center of 

the display for the selected channel.

<N> An integer, 1-4

<offset> The offset, valid values are -400 mV to 400 mV.

Example :CHAN1:OFFS 2.00000000000000E-01 
Query :CHANnel<N>: OFFSet?

The query returns the current offset value for the specified channel.

Returned Format [:CHANnel<N>:OFFSet] <offset><NL>
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:CHANnel<N>:RANGe

Command :CHANnel<N>:RANGe <range>
Description The command defines the full-scale vertical axis of the selected channel. 

The values represent the full-scale deflection factor of the vertical axis in 
volts.

<N> An integer, 1-4

<range> The full-scale range of the ADC, valid values are 40 mV to 400 mV.

Example :CHAN1:RANG 2.00000000000000E-01
Query :CHANnel<N>: RANGe?

The query returns the current range value for the specified channel.

Returned Format [:CHANnel<N>:RANGe] <range><NL>

:CHANnel<N>:DPRocessing:DDC:CFRequency

Command :CHANnel<N>:DPRocessing:DDC:CFRequency 
{<frequency_value>}

Description The command sets the center frequency of the DDC for the specified 
channel.

<N> An integer, 1-4

<frequency_value> A floating point value representing the center 
frequency of the input signal. The valid range for a sample frequency of 16 
GSa/s is from -8 GHz to +8 GHz, for 32 GSa/s from -16 GHz to +16 GHz.

Query :CHANnel<N>:DPRocessing:DDC:CFRequency?

NOTE
In modules with differential inputs, the query always returns 
0.00000000000000E+00 and setting any value not equal to 0 results in 
an error.

NOTE
In modules with differential inputs, the query always returns 
5.00000000000000E-0 and setting any value not equal to 0.5 results in 
an error.
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The query returns the current center frequency of the DDC for the 
specified channel.

Returned Format [:CHANnel<N>:DPRocessing:DDC:CFRequency] 
<frequency_value><NL>

:CHANnel<N>:DPRocessing: CHARacteris[:VALue]

Query :CHANnel<N>:DPRocessing:CHARacteris[:VALue]? [{S16G | 
S32G}]

Description The query returns the frequency and phase response data for a channel as 
a string of comma-separated values.

<N> An integer, 1-4

Returned Format [:CHANnel<N>:DPRocessing: CHARacteris[:VALue]]

<freq_resp><NL>

<freq_resp> A comma-separated list of 321 triples. Each triple consists of:

• Input frequency in Hz starting at 0 Hz with a spacing of 25 MHz for a 
sample rate of 16 GSa/s and 50 MHz for a sample rate of 32 GSa/s.

• Corresponding relative magnitude in linear scale

• Corresponding phase in radians

Example of the returned frequency response data for 32 GSa/s mode:

0.000000000E+00,1.000000000E+00, 0.000000000E+00,

5.000000000E+07,9.998865128E-01,-4.444515407E-01,

...

1.595000013E+10,3.858275712E-01,-9.671807861E+01,

1.600000000E+10,3.722717166E-01,-9.718323517E+01
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:CHANnel<N>:DPRocessing:FILTer[:VALue]

Command :CHANnel<N>:DPRocessing:FILTer[:VALue] {[{S16G | 
S32G}], filter_values}

Description The command sets the 49 correction filter coefficients for the specified 
channel. If the optional parameter of sample rate mode is given, it sets the 
filter values for the specified sample rate otherwise for the current sample 
rate mode. The correction filter is applied directly after the conversion by 
the ADC and before further processing, for example by the DDC.

<N> An integer, 1-4

S16G Selects the coefficients for 16GSa/s

S32G Selects the coefficients for 32GSa/s

<filter_values> The set of 49 coefficients as comma separated ASCII list or 
binary block of doubles. Each coefficient is in the range [-2;+2]. The 
frequency response of the correction filter is not allowed to exceed a gain 
of 2.0 over the entire frequency range.

Query :CHANnel<N>:DPRocessing:FILTer[:VALue]? [{S16G | S32G}] 

The query returns the current coefficients for the correction filter for the 
specified channel. If the optional parameter of sample rate mode is given, 
it returns the filter values for the specified sample rate otherwise for the 
current sample rate mode.

Returned Format :[:CHANnel<N>:DPRocessing:FILTer[:VALue]] <filter_values> <NL>

:CHANnel<N>:DPRocessing:FILTer:DEFault

Command :CHANnel<N>:DPRocessing:FILTer:DEFault [{S16G | 
S32G}]

Description The command sets the default values for the 49 correction filter 
coefficients for the specified channel. If the optional parameter of sample 
rate mode is given, it sets the default filter values for the specified sample 
rate otherwise for the current sample rate mode.

<N> An integer, 1-4

S16G Selects the coefficients for 16GSa/s

S32G Selects the coefficients for 32GSa/s

Query :CHANnel<N>:DPRocessing:FILTer:DEFault? [{S16G | S32G}] 
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The query returns the default values for the coefficients for the correction 
filter for the specified channel. If the optional parameter of sample rate 
mode is given, it returns the default filter values for the specified sample 
rate otherwise for the current sample rate mode.

Returned Format [:CHANnel<N>:DPRocessing:FILTer:DEFault] <filter_values> <NL>

:CHANnel<N>:DPRocessing:FILTer:SCALe

Command :CHANnel<N>:DPRocessing:FILTer:SCALe <scale>
Description The command sets the correction filter scaling factor for a channel.

<N> An integer, 1-4

<scale> The correction filter scaling factor between 0 and 2.

Query :CHANnel<N>:DPRocessing:FILTer:SCALe? 

The query returns the current correction filter scaling factor for a channel.

Returned Format [:CHANnel<N>:DPRocessing:FILTer:SCALe] <scale> <NL>

:CHANnel<N>:DPRocessing:FILTer:STATe

Command :CHANnel<N>:DPRocessing:FILTer:STATe {ON | 1} | {OFF | 
0}

Description The command sets the state of the correction filter - on or off.

<N> An integer, 1-4

Query :CHANnel<N>:DPRocessing:FILTer:STATe? 

The query returns the current state of the correction filter for a channel.

Returned Format [:CHANnel<N>:DPRocessing:FILTer:STATe] {1 | 0} <NL>
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:CHANnel<N>:DPRocessing:DDC:CFRequency:QUOTient?

Query :CHANnel<N>:DPRocessing:DDC:CFRequency:QUOTient?
Description This query gives the exact center frequency fC as a list of numbers: sign, 

upper 32 bit of the numerator (NumH), lower 32 bit of the numerator 
(NumL), upper 32 bit of the denominator (DenomH), lower 32 bit of the 
denominator (DenomL).

The sign is a signed value and can be “-1” or “+1”. The other four values 
are unsigned. The resulting quotient has to be multiplied by the sample 
rate fS to get the center frequency according to this formula:

fC = sign * (NumH * 232 + NumL) / (DenomH * 2
32 + DenomL) * fS

<N> An integer, 1-4

Example The sample rate is 16GHz.

:CHANnel1:DPRocessing:DDC:CFRequency:QUOTient?

1,8601,2576980378,65536,0

fC = 1 * (8601* 232 + 2576980378) / (65536 * 232 + 0) * 16GHz = 

2.100 000 000 000 022 GHz
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Data Processing Commands

:DPRocessing[:MODE]

Command :DPRocessing[:MODE] {DIRect|DDC}
Description The command selects the data processing mode for all channels. The 

selected mode determines, which type of data is forwarded to the capture 
memory and the ODI port.

DIRect: No data processing, the raw ADC samples are forwarded to the 
capture memory and the ODI port.

DDC: Digital-down conversion, the ADC samples are down-converted 
from the center frequency to baseband followed by a decimation and then 
forwarded to the capture memory and the ODI port.

Query :DPRocessing[:MODE]?
The query returns the current data processing mode for the specified 
channel.

Returned Format :DPRocessing[:MODE]] {DIRect | DDC}<NL>

:DPRocessing:DDC:DECimation

Command :DPRocessing:DDC: DECimation {POW2 | POW3 |POW4|POW5 | 
POW6 | POW7 |POW8 | POW9}

Description The command sets the decimation factor of the DDC for all channels. All 
decimation factors are powers of 2.

POW2 22

POW3 23

POW4 24

POW5 25

POW6 26

POW7 27 
POW8 28

POW9 29 
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Query :DPRocessing:DDC:DECimation?
The query returns the current decimation factor of the DDC for the 
specified channel.

Returned Format <N>:DPRocessing:DDC: DECimation] {POW2 | POW3 | POW4 
|POW5 | POW6 | POW7 | POW8| POW9} <NL>

:DPRocessing:DIRect:DECimation

Command DPRocessing:DIRect:DECimation {POW0 | POW1 |POW2}
Description The command sets the decimation factor of the Direct mode for all 

channels. All decimation factors are powers of 2.

Parameters POW0 20

POW1 21

POW1 22

Example Command

:DPR:DIR:DEC POW1
Query

:DPR:DIR:DEC? -> POW1
The query returns the current decimation factor of the Direct mode for the 
specified channel.

:DPRocessing:CAPability:DECimation?

Query :DPRocessing:CAPability:DECimation?
Description The query returns the list of all the available decimation factors.
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:DPRocessing:DDC:RESet

Command :DPRocessing:DDC:RESet [<channel_mask>]
Description The command resets the phase of the DDC. 

<channel_mask> Bit field specifying, for which channel the DDC phase should be reset.

Bit 0: channel 1

Bit 1: channel 2

Bit 2: channel 3

Bit 3: channel 4

If the parameter is omitted, the DDC phases of all channels are reset.
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Common Commands

*IDN?

Read the instrument’s identification string which contains four fields 
separated by commas. The first field is the manufacturer’s name, the 
second field is the model number, the third field is the serial number, and 
the fourth field is a revision code which contains four numbers separated 
by dots and a fifth number separated by a dash:

Keysight Technologies, M8131A,<serial number>, 
x.x.x.x-h
x.x.x.x= Soft Front Panel revision number, e.g. 2.0.0.0

h= Hardware revision number

*CLS

Clear the event register in all register groups. This command also clears 
the error queue and cancels a *OPC operation. It doesn’t clear the enable 
register.

*ESE

Enable bits in the Standard Event Status Register to be reported in the 
Status Byte. The selected bits are summarized in the “Standard Event” bit 
(bit 5) of the Status Byte Register. The *ESE? query returns a value which 
corresponds to the binary-weighted sum of all bits enabled decimal by the 
*ESE command. These bits are not cleared by a *CLS command. Value 
Range: 0–255.

ESR?

Query the Standard Event Status Register. Once a bit is set, it remains set 
until cleared by a *CLS (clear status) command or queried by this 
command. A query of this register returns a decimal value which 
corresponds to the binary-weighted sum of all bits set in the register.

*OPC

Set the “Operation Complete” bit (bit 0) in the Standard Event register 
after the previous commands have been completed.
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*OPC?

Return “1” to the output buffer after the previous commands have been 
completed. Other commands cannot be executed until this command 
completes.

*OPT?

Read the installed options. The response consists of any number of fields 
separated by commas.

*RST

Reset instrument to its factory default state.

*SRE[?]

Enable bits in the Status Byte to generate a Service Request. To enable 
specific bits, you must write a decimal value which corresponds to the 
binary-weighted sum of the bits in the register. The selected bits are 
summarized in the “Master Summary” bit (bit 6) of the Status Byte 
Register. If any of the selected bits change from “0” to “1”, a Service 
Request signal is generated. The *SRE? query returns a decimal value 
which corresponds to the binary-weighted sum of all bits enabled by the 
*SRE command.

*STB?

Query the summary (status byte condition) register in this register group. 
This command is similar to a Serial Poll but it is processed like any other 
instrument command. This command returns the same result as a Serial 
Poll but the “Master Summary” bit (bit 6) is not cleared by the *STB? 
command.

*TST?

Execute Self Tests. If self-tests pass, a 0 is returned. A number lager than 0 
indicates the number of failed tests.

To get actual messages, use :TEST:TST?
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*LRN?

Query the instrument and return a binary block of data containing the 
current settings (learn string). You can then send the string back to the 
instrument to restore this state later. For proper operation, do not modify 
the returned string before sending it to the instrument. Use :SYST:SET to 
send the learn string. See :SYSTem:SET[?] on page 155.

*WAI?

Prevents the instrument from executing any further commands until the 
current command has finished executing.
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Mass Memory Commands

The MMEMory subsystem allows to access files on the host executing the 
M8131A firmware.

:MMEMory:CATalog? 

Query :MMEMory:CATalog? [<directory_name>]
Description Query disk usage information (drive capacity, free space available) and 

obtain a list of files and directories in a specified directory in the following 
format:

<numeric_value>,<numeric_value>,{<file_entry>}
The command returns two numeric parameters and as many strings as 
there are files and directories. The first parameter indicates the total 
amount of storage currently used in bytes. The second parameter indicates 
the total amount of storage available, also in bytes. The <file_entry> is 
a string. Each <file_entry> indicates the name, type, and size of one 
file in the directory list:

<file_name>,<file_type>,<file_size>
As the Windows file system has an extension that indicates file type, 
<file_type> is always empty. <file_size> provides the size of the 
file in bytes. In case of directories, <file_entry> is surrounded by 
square brackets and both <file_type> and <file_size> are empty.

Example Query

:MMEM:CAT?

NOTE
MMEM commands requiring <directory_name> assume the current 
directory if a relative path or no path is provided. If an absolute path is 
provided, then it is ignored.
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:MMEMory:CDIRectory 

Command :MMEMory:CDIRectory [<directory_name>]
Description The command changes the default directory for a mass memory file 

system. The <directory_name> parameter is a string. If no parameter is 
specified, the directory is set to the *RST value. At *RST, this value is set 
to the default user data storage area, that is defined as 
System.Environment.SpecialFolder.Personal

e.g. C:\Users\Name\Documents
MMEMory:CDIRectory? — Query returns full path of the default 
directory.

Parameter <directory_name>
Example Command

:MMEM:CDIR “C:\Users\Name\Documents”
Query

:MMEM:CDIR?

:MMEMory:COPY

Command :MMEMory:COPY <string>,<string>[,<string>,<string>]
Description The command copies an existing file to a new file or an existing directory to 

a new directory. Two forms of parameters are allowed. The first form has 
two parameters. In this form, the first parameter specifies the source, and 
the second parameter specifies the destination.

The second form has four parameters. In this form, the first and third 
parameters specify the file names. The second and fourth parameters 
specify the directories. The first pair of parameters specifies the source. 
The second pair specifies the destination. An error is generated if the 
source doesn't exist or the destination file already exists.

Parameters <string>,<string>
Example Command

:MMEM:COPY "C:\data.txt", "C:\data_new.txt"
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:MMEMory:DELete

Command :MMEMory:DELete <file_name>[,<directory_name>]
Description The command removes a file from the specified directory. The 

<file_name> parameter specifies the file to be removed.

Parameters <file_name>
Example Command

:MMEM:DEL "C:\data.txt"

:MMEMory:DATA

Command :MMEMory:DATA <file_name>, <data>
Description The command form is MMEMory:DATA <file_name>,<data>. It loads 

<data> into the file <file_name>. <data> is in 488.2 block format. 
<file_name> is string data.

Parameters <file_name>, <data>
Example Command

:MMEM:DATA “C:\data.txt”, #14test

:MMEMory:DATA:APPend

Command :MMEMory:DATA:APPend <file_name>, <data>
Description The command form is MMEMory:DATA:APPend <file_name>,<data>. It 

appends <data> to the existing file <file_name>. <data> is in 488.2 block 
format.

<file_name> is string data.

Parameters <file_name>, <data>
Example Command

:MMEM:DATA:APP "C:\data.txt", #14test
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:MMEMory:DATA? 

Query :MMEMory:DATA? <file_name>
Description The query form is MMEMory:DATA? <file_name> with the response 

being the associated <data> in block format.

Parameters <file_name>
Example Query

:MMEM:DATA? “C:\data.txt”

:MMEMory:MDIRectory 

Command :MMEMory:MDIRectory <directory_name>
Description The command creates a new directory. The <directory_name> 

parameter specifies the name to be created.

Parameters <directory_name>
Example Command

:MMEM:MDIR "C:\data_dir"

:MMEMory:MOVE

Command :MMEMory:MOVE <string>,<string>[,<string>,<string>]
Description The command moves an existing file to a new file or an existing directory to 

a new directory. Two forms of parameters are allowed. The first form has 
two parameters. In this form, the first parameter specifies the source, and 
the second parameter specifies the destination.

The second form has four parameters. In this form, the first and third 
parameters specify the file names. The second and fourth parameters 
specify the directories. The first pair of parameters specifies the source. 
The second pair specifies the destination. An error is generated if the 
source doesn't exist or the destination file already exists.

Parameters <string>,<string>
Example Command

:MMEM:MOVE "C:\data_dir","C:\newdata_dir"
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:MMEMory:RDIRectory 

Command :MMEMory:RDIRectory <directory_name>
Description The command removes a directory. The <directory_name> parameter 

specifies the directory name to be removed. All files and directories under 
the specified directory are also removed.

Parameters <directory_name>
Example Command

:MMEM:RDIR "C:\newdata_dir"

:MMEMory:LOAD:CSTate

Command :MMEMory:LOAD:CSTate <file_name>
Description Current state of instrument is loaded from a file.

Parameters <file_name>
Example Command

:MMEM:LOAD:CST "C:\data.txt"

:MMEMory:STORe:CSTate

Command :MMEMory:STORe:CSTate <file_name>
Description Current state of instrument is stored to a file.

Parameters <file_name >
Example Command

:MMEM:STOR:CST "C:\data.txt"
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:MMEMory:STORe:WAVeform

Command :MMEMory:STORe::WAVeform CHANnel<N>, "<file_name>" 
[,<format>[,<header>]]

Description Saves a waveform from the selected channel to a file.

<N> An integer, 1-4.

<file_name> A quoted ASCII string with a maximum of 254 characters 
including the entire path name, if used. The filename assumes the present 
working directory if a path does not precede the file name.

<format> {TXT } ASCII file format. If the DPRocessing:MODE is 
DIRect, data consists of voltage values separated by a carriage return 
and line feed. If the DPRocessing:MODE is DDC, data consists of IQ value 
pairs separated by a carriage return and line feed. The two values of a pair 
are separated by a comma.

<header> {{ON | 1} | {OFF | 0}}
ON | 1 A header precedes the data.

OFF | 0 Only data without header (default).

Example: File header and beginning of data for a waveform captured in 
DIRect mode:

Revision: 0
Type:     raw
Points:   1600
XInc:     6.25e-11
XOrg:     0
XUnits:   second
YInc:     0.0005
YOrg:     0
YUnits:   Volt
Data:
3.23486E-02
3.33252E-02
...
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Example: File header and beginning of data for a waveform captured in 
DDC mode:

Revision: 0
Type:     iqd
Points:   1600
XInc:     6.25e-11
XOrg:     0
XUnits:   second
YInc:     0.0005
YOrg:     0
YUnits:   Volt

Data:
1.23486E-02, 1.33252E-02
1.25348E-02, 1.39842E-02
...

Example Command

:MMEM:STORe:WAVeform CHANnel1, "waveform.txt", TXT, 
ON
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Root Level Commands

The Root Level commands control many of the basic operations of the 
digitizer.

:DIGitize

Command :DIGitize
The command initializes the selected channels, then starts acquisition of 
ADC samples into capture memory. When all waveforms are completely 
acquired, the acquisition is stopped.

In Direct mode the captured ADC samples are displayed in the time and 
frequency domain windows of the GUI. In DDC mode they are only 
displayed in the frequency domain window.

When the digitizer receives this command, it initializes the selected 
channels according to the current acquire and trigger settings. It sets the 
Memory Capture in Progress bit of the Memory Capture Status Subsystem 
and returns to the caller. When the capture is completed, the Memory 
Capture in Progress bit is reset to 0. Before reading the data from the 
capture memory using the :WAVeform:DATA query, the caller should 
verify, that the Capture in Progress bit is 0. For more information on 
Memory Capture Status Subsystem, refer to Memory Capture Status 
Subsystem on page 119.

:DIGitize:NDISplay

Command :DIGitize:NDISplay
Same as the :DIGitize command, but the GUI displays are not updated.

:RUN

Command :RUN
This command is equivalent to repetitively calling the :DIGitize command. 
Command execution can be stopped with the :STOP command.

:STOP

Command :STOP
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The command causes the digitizer to stop acquiring data into capture 
memory. It can be used to abort a :DIGitize, :DIGitize:NDISplay or :RUN 
command. 

:STReam

Command :STReam
This command is only available with option STR. It starts ODI streaming on 
all ports, that are activated and for which the data producer is activated. 
See commands :ODI:PORT<N>:ACTivate on page 168 and 
:ODI:PRODucer<N>:ACTivate on page 173. If the DDC (Digital Down 
Conversion) is switched on, IQ samples are streamed. If the DDC is 
switched off, raw data samples are streamed.

Example: Stream out IQ data samples on ODI port 1

// Activate ODI port as producer.

:ODI:PORT1:ACT R141, 2048, PROD, NONE, NONE, ""

// Activate ODI port as consumer on the other side of the ODI link.

// Read ODI port communication status and wait until ODI link is up. 

// Active, TxReady and RxReady (bits 0-3) of the returned status should // 
all be 1.

:ODI:PORT1:CST?

// Activate the data producer.

:ODI:PROD1:ACT 0, NHE, IQ16B1CH, ODIC, NTIM, 1, 26214

// Activate the data consumer on the other side of the ODI link.

// Start ODI streaming.

:STR
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:SSTReam

Command :SSTReam
This command is only available with option STR. It stops ODI streaming on 
all ports.

Example: Stop the data streaming on ODI port 1.

// Stop ODI streaming.

:SSTR

// De-activate the data producer. 

:ODI:PROD1:DEAC

// De-activate the data consumer on the other side of the ODI link.

// De-activate ODI port.

:ODI:PORT1:DEAC

// De-activate ODI port on the other side of the ODI link.
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System Commands

:SYSTem:ERRor[:NEXT]?

Query :SYSTem:ERRor?
Description The query read and clear one error from the instrument’s error queue.

A record of up to 30 command syntax or hardware errors can be stored in 
the error queue. Errors are retrieved in first-in-first-out (FIFO) order. The 
first error returned is the first error that was stored. Errors are cleared as 
you read them.

If more than 30 errors have occurred, the last error stored in the queue 
(the most recent error) is replaced with “Queue overflow”. No additional 
errors are stored until you remove errors from the queue.

If no errors have occurred when you read the error queue, the instrument 
responds with 0,“No error”.

The error queue is cleared by the *CLS command, when the power is 
cycled, or when the Soft Front Panel is re-started.

The error queue is not cleared by a reset (*RST) command.

The error messages have the following format (the error string may contain 
up to 255 characters):

error number,”Description”, e.g.

-113,”Undefined header”.

Example Query

:SYST:ERR?

:SYSTem:HELP:HEADers?

Query :SYSTem:HELP:HEADers?
Description The query returns all SCPI commands and queries and IEEE 488.2 

common commands and common queries implemented by the instrument. 
The response is a <DEFINITE LENGTH ARBITRARY BLOCK RESPONSE 
DATA> element. The full path for every command and query is returned 
separated by linefeeds. 
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The syntax of the response is defined as: The <nonzero digit> and 
sequence of <digit> follow the rules in IEEE 488.2, Section 8.7.9. A <SCPI 
header> is defined as: It contains all the nodes from the root. The <SCPI 
program mnemonic> contains the node in standard SCPI format. The short 
form uses uppercase characters while the additional characters for the 
long form are in lowercase characters. Default nodes are surrounded by 
square brackets ([]).

Example Query

:SYST:HELP:HEAD?

:SYSTem:LICense:EXTended:LIST?

Query :SYSTem:LICense:EXTended:LIST?
Description The query lists the licenses installed.

Example Query

:SYST:LIC:EXT:LIST?

:SYSTem:SET[?]

Command :SYSTem:SET[?] <binary block data>
Description In query form, the command reads a block of data containing the 

instrument’s complete set-up. The set-up information includes all 
parameter and mode settings, but does not include the contents of the 
instrument setting memories or the status group registers. The data is in a 
binary format, not ASCII, and cannot be edited.

In set form, the block data must be a complete instrument set-up read 
using the query form of the command.

This command has the same functionality as the *LRN command.

Parameters <binary block data>

Example Command

:SYST:SET <binary block data>
Query

:SYST:SET?
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:SYSTem:VERSion?

Command :SYSTem:VERSion?
Description The query returns a formatted numeric value corresponding to the SCPI 

version number for which the instrument complies.

Example Query

:SYST:VERS?

:SYSTem:COMMunicate:*?

Command :SYSTem:COMMunicate:*?
Description The query returns information about the instrument Soft Front Panel’s 

available connections. If a connection is not available, the returned value 
is -1.

This is only useful if there is more than one Keysight module connected to 
a PC, otherwise one would normally use the default connections (HiSLIP 
and VXI-11 instrument number 0, socket port 5025, telnet port 5024)

One can never be sure if a socket port is already in use, so one could e.g. 
specify a HiSLIP number on the command line (AgM8131SFP.exe /AutoID 
/Inst5 /FallBack /r …) and let the Soft Front Panel find an unused socket 
port. Then this socket port can be queried using the HiSLIP connection.

Example Query

:SYST:COMM:*?

:SYSTem:COMMunicate:INSTr[:NUMBer]?

Command :SYSTem:COMMunicate:INSTr?
Description The query returns the VXI-11 instrument number used by the Soft Front 

Panel.

Example Query

:SYST:COMM:INST?
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:SYSTem:COMMunicate:HISLip[:NUMBer]?

Command :SYSTem:COMMunicate:HISLip?
Description The query returns the HiSLIP number used by the Soft Front Panel.

Example Query

:SYST:COMM:HISL?

:SYSTem:COMMunicate:SOCKet[:PORT]?

Command :SYSTem:COMMunicate:SOCKet?
Description The query returns the socket port used by the Soft Front Panel.

Example Query

:SYST:COMM:SOCK?

:SYSTem:COMMunicate:TELNet[:PORT]?

Command :SYSTem:COMMunicate:TELNet?
Description The query returns the telnet port used by the Soft Front Panel.

Example Query

:SYST:COMM:TELN?

:SYSTem:COMMunicate:TCPip:CONTrol?

Command :SYSTem:COMMunicate:TCPip:CONTrol?
Description The query returns the port number of the control connection. You can use 

the control port to send control commands (for example “Device Clear”) to 
the instrument.

Example Query

:SYST:COMM:TCP:CONT?
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:SYSTem:ERRor:COUNt?

Command :SYSTem:ERRor:COUNt?
Parameters None

Description This query returns the error count.

Examples Query

:SYST:ERR:COUNt? -> “5”
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Time Base Commands

The TIMebase subsystem commands control the reference clock source of 
the digitizer.

:TIMebase:REFClock

Command :TIMebase:REFClock{INTernal | E010 | E100}
Description The command selects the reference clock source.

INTernal Internal 10 MHz reference oscillator (default)

E010 External 10 MHz reference

E100 External 100 MHz reference

The following errors are detected, when an external reference clock source 
is selected:

• Amplitude of external reference signal too small.

• Amplitude of external reference signal too big.

• Frequency of external reference signal out-of-range.

These errors are reported in the STATus subsystem. After selecting a new 
reference clock source, the status should be queried. In all these error 
cases, the external reference signal is not usable, and the module 
automatically selects the internal reference oscillator.

Query :TIMebase:REFClock?
The query returns the currently selected reference clock source.

Returned Format [:TIMebase:REFClock] {INTernal | E010 | E100}<NL>
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Waveform Commands

The Waveform subsystem is used to transfer waveform data between a 
computer and the digitizer. It contains commands to set up the waveform 
transfer and to receive waveform records from the digitizer.

:WAVeform:BYTeorder

Command :WAVeform:BYTeorder {MSBFirst | LSBFirst}
Description The command selects the order in which bytes are transferred from the 

digitizer using WORD format.

MSBFirst The most significant byte is transferred first.

LSBFirst The least significant byte is transferred first (default).

Query :WAVeform:BYTeorder?
The query returns the current setting for the byte order.

Returned Format [:WAVeform:BYTeorder] {MSBFirst | LSBFirst}<NL>

:WAVeform:DATA?

Query :WAVeform:DATA? CHANnel<N>, <start>,<size>
Description The query outputs waveform data to the computer over the remote 

interface. The data is copied from a channel given by the first parameter. 
The waveform data is ASCII formatted. The data consists of waveform data 
values converted to volts and is formatted as a string of ASCII characters 
with each value separated from the next value by a comma. The values are 
formatted in floating point engineering notation. For example:

8.0836E+2,8.1090E+2,...,-3.1245E-3

If DPRocessing is set to DIRect, 10-bit ADC samples in signed 16-bit 
integer representation are transferred. If set to DDC, 16-bit I and 16-bit Q 
samples interleaved in signed 16-bit integer representation are 
transferred.

<N> An integer, 1-4.

<start> An integer value which is the starting point in the source 
memory which is the first waveform point to transfer.
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<size> An integer value which is the number of points in the source 
memory to transfer. If the size specified is greater than the amount of 
available data, then the size is adjusted to be the maximum available 
memory depth minus the <start> value.

Returned Format [:WAVeform:DATA] {ascii_list}<NL>

:WAVeform:DATA:BLOCk?

Query :WAVeform:DATA:BLOCk? CHANnel<N>, <start>,<size>
Description The query outputs waveform data to the computer over the remote 

interface. The data is copied from a channel given by the first parameter. 
The waveform data is in binary block format. The data is transferred as 
signed 16-bit integers. If :WAVeform:BYTeorder is set to MSBFirst, the 
most significant byte of each word is sent first. If the BYTeorder is LSBFirst, 
the least significant byte of each word is sent first.

If DPRocessing is set to DIRect, 10-bit ADC samples in signed 16-bit 
integer representation are transferred. If set to DDC, 16-bit I and 16-bit Q 
samples interleaved in signed 16-bit integer representation are 
transferred.

<N> An integer, 1-4.

<start> An integer value which is the starting point in the source memory 
which is the first waveform point to transfer.

<size> An integer value which is the number of points in the source 
memory to transfer. If the size specified is greater than the amount of 
available data then the size is adjusted to be the maximum available 
memory depth minus the <start> value.

Returned Format [:WAVeform:DATA:BLOCk] {binary_block_data}<NL>

:WAVeform:XINCrement?

Command :WAVeform:XINCrement? CHANnel<N>
Description This query returns the time difference between consecutive data points for 

the channel given by the first parameter.

<N> An integer, 1-4.

Example :WAVeform:XINCrement? CHAN1 -> 6.25000000000000E-11
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:WAVeform:XORigin?

Command :WAVeform:XORigin? CHANnel<N>
Description This query returns the time value of the first point in the data record for the 

channel given by the first parameter.

<N> An integer, 1-4.

Example :WAVeform:XORigin? CHAN1 -> 0.00000000000000E+00

:WAVeform:YINCrement?

Command :WAVeform:YINCrement? CHANnel<N>
Description This query returns the y-increment voltage for the channel given by the 

first parameter. This voltage value is the voltage difference between two 
adjacent waveform data digital codes.

<N> An integer, 1-4.

Example :WAVeform:YINCrement? CHAN1 -> 5.00000000000000E-04

:WAVeform:YORigin?

Command :WAVeform:YORigin? CHANnel<N>
Description This query returns the y-origin voltage value for the channel given by the 

first parameter. The voltage value returned is the voltage value 
represented by the waveform data digital code zero.

<N> An integer, 1-4.

Example :WAVeform:YORigin? CHAN1 -> 0.00000000000000E+00
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Instrument Commands

The INSTrument subsystem contains queries to get information like 
occupied AXIe slot number, M8131A hardware revision, available channels 
and capture memories.

:INSTrument:SLOT[:NUMBer]?

Query :INSTrument:SLOT[:NUMBer]?
Description The query returns the instrument’s slot number in its AXIe frame 

Returned Format [:INSTrument:SLOT[:NUMBer]] {slot_number}<NL>

:INSTrument:IDENtify

Command :INSTrument:IDENtify <seconds>
Description The command identifies the instrument by flashing the green “Access” LED 

on the front panel for a certain time.

<seconds> Optional length of the flashing interval in seconds, default is 
10.

:INSTrument:IDENtify:STOP

Command :INSTrument:IDENtify:STOP
Description The command stops the flashing of the green “Access” LED before the 

flashing interval has elapsed.

:INSTrument:HWRevision?

Query :INSTrument:HWRevision?
Description The query returns the instrument’s hardware revision number. 

Returned Format [:INSTrument:HWRevision] {hw_revision}<NL>
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:INSTrument:AINPuts?

Query :INSTrument:AINPuts?
Description The query returns the usable analog input channels as a string. The 

channel names are separated by commas. The returned value depends on 
the installed options and the selected sample rate.

Returned Format [:INSTrument:AINPuts] {active_channels_string}<NL>

:INSTrument:AMEMory?

Query :INSTrument:AMEMory?
Description The query returns the usable capture memories as a string. The memory 

names are separated by commas. The returned value depends on the 
installed options and the selected sample rate.

Returned Format [:INSTrument:AMEMory] {active_channels_string}<NL>

:INSTrument:MONitor:TEMPerature?

Query :INSTrument:MONitor: TEMPerature? {ADC | LACal | FA | 
FB}

Description The query returns the temperature for the selected component.

ADC Current ADC temperature

LACal Temperature of last ADC calibration

FA Temperature of FPGA A

FA Temperature of FPGA B

Returned Format [:INSTrument:MONitor:TEMPerature] <value>
Example :INST:MON:TEMP? ADC -> 7.09999990463257E+01
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Optical Data Interface Commands

The Optical Data Interface subsystem is used to setup the optical ports of 
the M8131A. These commands are only available with option -STR. An 
example sequence of commands to set up the ODI ports for data 
streaming is shown in the description of the :STReam command. This 
product implements a subset of the “Application Programming Interface 
for Test and Measurement - Optical Data Interface, Revision 2.0”.

The complete specification can be found here: 
http://axiestandard.org/odispecifications.html

:ODI:ACHannels?

Command :ODI:ACHannels?
Description The query returns the usable optical channels as a string. The channel 

names are separated by commas. The returned value depends on the 
installed options and the selected sample rate.

<N> An integer to select the ODI port, 1-4.

Returned Format [:ODI:ACHannels] {active_channels_string}<NL>

:ODI:PORT:COUNt?

Query :ODI:PORT:COUNt?
Description The query returns the total number of ODI channels.

Return Format [:ODI:PORT:COUNt] <ports><NL>
Example :ODI:PORT:COUNt? -> 4

:ODI:PORT<N>:CAPability:DIRection? 

Query :ODI:PORT<N>:CAPability:DIRection?
Description The query returns the list of data transfer directions supported by this port.

Return Format [:ODI:PORT<N>:CAPability:DIRection] 
<direction-list><NL>
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<direction-list>: [BIDirection | PRODucer | CONSumer | 
DUDirection] [,…] 

Example :ODI:PORT:CAP:DIR? -> “CONSumer, BIDirection”

:ODI:PORT<N>:CAPability:FCONtrols?

Query :ODI:PORT1:CAPability:FCONtrols?
Parameters None 

Description The query returns the list of flow control types supported by this port.

Return Format [:ODI:PORT1:CAPability:FCONtrols] 
<flow-control-list><NL>
<flow-control-list>: [NONE | IBANd | IBPChannel | 
OOBWire | OOBBplane<M>] [,…] 
<M> An integer, 0 - 13 

Example :ODI:PORT1:CAP:FCON? -> “NONE, IBANd”

:ODI:PORT<N>:CAPability:LANes?

Query :ODI:PORT<N>:CAPability:LANes?
Parameters None 

Description The query returns the number of lanes supported by this port.

Return Format [:ODI:PORT<N>:CAPability:LANes] <lanes><NL>
Example :ODI:PORT1:CAP:LAN? -> 12

:ODI:PORT<N>:CAPability:NAME?

Query :ODI:PORT<N>:CAPability:NAME?
Parameters None 

Description The query returns the name of the port.

Return Format [:ODI:PORT<N>:CAPability:NAME] <name><NL>
Example :ODI:PORT:CAP:NAME? -> “ODI1”
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:ODI:PORT<N>:CAPability:RATes?

Query :ODI:PORT1:CAPability:RATes?
Parameters None 

Description The query returns the list of lane rates supported by this port. 

Return Format [:ODI:PORT1:CAPability:RATes] <rate-list><NL>
<rate-list>: [R125 | R141] [,…]

Example :ODI:PORT1:CAP:RAT? -> “R141”

:ODI:PORT<N>:CAPability:RBMax?

Query :ODI:PORT<N>:CAPability:RBMax?
Parameters None 

Description The query returns the supported receiver maximum burst values.

Return Format [:ODI:PORT<N>:CAPability:RBMax] <burst-max-list><NL>
<burst-max-list>: [256 | 2048] [,…]

Example :ODI:PORT:CAP:RBM? -> 2048

:ODI:PORT<N>:CAPability:TBMax?

Query :ODI:PORT<N>:CAPability:TBMax?
Parameters None 

Description The query returns the supported transmitter maximum burst values. 

Return Format [:ODI:PORT<N>:CAPability:TBMax] <burst-max-list><NL>
<burst-max-list> ::= [256 | 2048] [,…]

Example ODI:PORT:CAP:TBMax? -> 256,2048
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:ODI:PORT<N>:CAPability:TRMatch?

Query :ODI:PORT:CAPability:TRMatch?
Parameters None 

Description The query returns a Boolean value, indicating if transmission rate matching 
is supported.

Return Format [:ODI:PORT:CAPability:TRMatch] <rate-match><NL>
Example :ODI:PORT:CAP:TRM? -> 0

:ODI:PORT<N>:NAME?

Query :ODI:PORT:NAME?
Parameters None 

Description The query returns the name of the port.

Return Format [:ODI:PORT:NAME] <name><NL>
Example :ODI:PORT:NAME? -> “ODI1”

:ODI:PORT<N>:ACTivate

Command :ODI:PORT<N>:ACTivate <lane_rate>, <tx_burst_max>, 
<directionality>, <tx_flow_control>, 
<rx_flow_control>, <options>

Description The command switches on the optical port using the specified parameters.

<N> An integer to select the ODI port, 1-4.

<lane_rate> Lane rate

R141 14.1 Gbit/s.

<tx_burst_max> Maximum transmit burst size in bytes. Possible values 
are 256 and 2048

<directionality> Directionality

PRODucer Transmit direction

CONSumer Receive direction

<tx_flow_control> Transmit flow control

NONE
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IBANd In-band

<rx_flow_control> Receive flow control

NONE
IBANd In-band

<options> String to pass additional instrument-specific settings. For 
future expansion. Currently not used.

Query :ODI:PORT<N>:ACTivate?

Description When the port is active, this query returns the parameter values used in 
the command to activate the port.

:ODI:PORT<N>:DEACtivate

Command :ODI:PORT<N>:DEACtivate
Description The command switches off the optical port.

<N> An integer to select the ODI port, 1-4.

Example :ODI:PORT1:DEAC

:ODI:PORT<N>:CSTatus?

Query :ODI:PORT<N>:CSTatus?
Description The query returns the communication status of an optical port.

<N> An integer to select the ODI port, 1-4.

Returned Format [:ODI:PORT<N>:CSTatus] <status><NL>
<status> 32-bit integer, meaning of the status bits is described in 
Table 20  on page -170. 
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Table 20  

Status bits described with “since last GetStatus” are cleared by 
:ODI:PORT<N>:CSTatus? query. All status bits will be 0 on an inactive 
port.

:ODI:PORT<N>:PSTatistics:BBURsts? 

Query :ODI:PORT<N>:PSTatistics:BBURsts?
Parameters None 

Description This query returns the bad burst received by the ODI port.

Example :ODI:PORT1:PST:BBUR? -> <integer>

Name Bits Description

Active 0 Port activated by software. Actual readiness to send and receive will depend upon the opposite 
end of the link and flow control configuration. 

TxReady 1 Ready to transmit and flow control allows. If flow control is disabled, transmit will always be 
ready to send. If flow control is enabled, the port will not be ‘ready to send’ until receiver is ready 
and indicating XON via flow control. To troubleshoot TxReady not becoming set in this case, 
troubleshoot the receive path starting with RxSignalLoss. 

RxReady 2 Receiver ready.   All lanes synchronized and aligned.

RxLaneError 3 Error in one or more lanes since last GetStatus. 

RxBurstMaxError 4 Received too large a burst since last GetStatus.

RxCrcError 5 Received bad burst CRC since last GetStatus.

RxOverrun 6 Receiver data overrun since last GetStatus

RxSignalLoss 7 Received signal loss.  Optical power too low.   

RxSyncPending 8 Receiver activated but has not achieved synchronization

9 to 15 Unused

RxFcStatus 16 Received link-level flow control status. 1 is XON, 0 is XOFF. From Interlaken idle/control word bit 
55 or from an out-of-band flow control signal. 

RxFcStatus0
to
RxFcStatus14

17 
to 
31

Received per-channel flow control status bits. 1 is XON,  0 is XOFF.   Bit 17 is channel 0 from bit 
54 of the Interlaken idle/control word, bit 18 is channel 1 from bit 53 of the control word, and so 
on. 
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:ODI:PORT<N>:PSTatistics:RBYTes? 

Query :ODI:PORT<N>:PSTatistics:RBYTes?
Parameters None 

Description This query returns the number of bytes received by the ODI port.

Example :ODI:PORT1:PST:RBYT? -> <integer>

:ODI:PORT<N>:PSTatistics:TBYTes? 

Query :ODI:PORT<N>:PSTatistics:TBYTes?
Parameters None 

Description This query returns the number of bytes transmitted by the ODI port.

Example :ODI:PORT1:PST:TBYT? -> <integer>

:ODI:PORT<N>:PSTatistics:THOFfs? 

Query :ODI:PORT<N>:PSTatistics:THOFfs?
Parameters None 

Description This query returns the transmission holdoffs.

Example :ODI:PORT1:PST:THOF? -> <integer>

:ODI:PRODucer:COUNt? 

Command :ODI:PRODucer:COUNt?
Parameters None 

Description This query returns the number of current producer count in the collection.

Example :ODI:PORD:COUN? -> 4
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:ODI:PRODucer<N>:CAPability:CLIDs? 

Command :ODI:PRODucer<N>:CAPability:CLIDs?
Parameters None 

Description This query returns the class IDs.

Example :ODI:PROD1:CAP:CLID? -> "IQ16B1CH"

:ODI:PRODucer<N>:CAPability:CCIDs? 

Command :ODI:PRODucer<N>:CAPability:CCIDs?
Parameters None 

Description This query returns the context class IDs.

Example :ODI:PROD1:CAP:CCID? -> "ODIContext"

:ODI:PRODucer<N>:CAPability:NAME?

Command :ODI:PRODucer<N>:CAPability:NAME? 
Parameters None 

Description This query returns the name of the producer.

Example :ODI:PROD1:CAP:NAME? -> "Ch1 DDC to ODI1"

:ODI:PRODucer<N>:CAPability:PFORmats?

Command :ODI:PRODucer<N>:CAPability:PFORmats? 
Parameters None 

Description This query returns the name of the packet formats available. 

Example :ODI:PROD1:CAP:PFOR? -> "NHEader"
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:ODI:PRODucer<N>:NAME?

Command ODI:PRODucer<N>:NAME? 
Parameters None 

Description This query returns name of the producer. Useful if a port object passed by 
reference in programming environments. 

Example :ODI:PROD1:NAME? -> "Ch1 DDC to ODI1"

:ODI:PRODucer<N>:IFSupported

Command ODI:PRODucer<N>:IFSupported? 
Parameters None 

Description This query returns if the combination of packet format and binary data 
format (classId) is supported. 

Example :ODI:PRODucer2:IFSupported? NHEader,RE10B1CH-> 1

:ODI:PRODucer<N>:ACTivate

Command :ODI:PRODucer<N>:ACTivate <link_channel>, 
<packet_format>, <class_id>, <context_class_id>, 
<time_stamp_format>, <stream_id>, <packet_size_limit>

Description The command configures the data producer stream and activates it for 
use. Data sources in the digitizer are the 4 channels. This command is 
used to prepare streaming of the digitized data out of the digitizer's 
optical ports. The stream is started by the :STReam commands (see 
:STReam on page 152).

<N> An integer to select the ODI port, 1-4.

<link_channel> Interlaken channel tag to apply to stream (not the 
measurement channel). Must be 0.

<packet_format> Specifies format of packet header.

NHEader Raw binary samples with no header.
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<class_id> Specifies the binary data format of the packet payload.

Valid class ids are RE10B1CH, RE16B1CH, or IQ16B1CH, depending 
upon the instrument settings. All possible class ids can be determined 
using the :ODI:PRODUCER<N>:CAPABILITY:CLIDS? query. If a 
combination of packet format and binary data format (classId) is 
supported, can be determined using the 
ODI:PRODucer<N>:IFSupported? query.

RE10B1CH Real-only, 10-bit signed, 1 channel.

RE16B1CH Real-only, 16-bit signed, 1 channel.

IQ16B1CH Complex (IQ), 16-bit signed, 1 channel.

<context_class_id> Specifies format of context packets

NONE No context packet

ODIContext Specify Vita49 ODI context.

<time_stamp_format> Format of the time stamp 

NTIMestamp Timestamp not used.

<stream_id> Specifies VITA-49 Stream Identifier value to be placed in 
the IF Data Packet when using the VITA-49 packet format. The default 
stream id for Vita49 carried over ODI is 4096.

<packet_size_limit> Specifies a maximum size for packets, in bytes. 
0 indicates default of 262144.

:ODI:PRODucer<N>:DEACtivate

Command :ODI:PRODucer<N>:DEACtivate 
Parameters None 

Description This command deactivates the stream, stops any data flow, and frees 
resources. 

Example :ODI:PROD1:DEAC
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ODI Time Output Synchronization Subsystem

The ODI time output synchronization subsystem enables accurate 
synchronization of timestamps placed in ODI packets with an external time 
source, for example, the GPS in an M9506A AXIe chassis.

To synchronize the time, a pulse input on SYNC_IN or TRIG_IN front panel 
connectors at a known time is used to set up the time handling circuit. 
Subsequently, the time counters for individual ODI channels can be 
adjusted.

:ODI:TOSync

Command :ODI:TOSync ”<time>”
Description Synchronize the clock used to timestamp ODI packets to the specified time 

when a synchronization pulse is received. The synchronization pulse can 
be received on either ‘Sync In’ or ‘Trig In’ as specified by 
:ODI:TOSync:Source

<time> The time to be applied when the sync pulse is received, as a string. 
The string may either:

The decimal fraction form of number of seconds that have elapsed since 
January 1, 1970 (midnight UTC/GMT).

Or/

A time string specified as an ISO 8601 format string. 

The fractional second in both cases is parsed to 12 decimal places

Example :ODI:TOSync "1577836800.000000000000"
:ODI:TOSync "2000-02-22T16:19:11.8008352000+00:00"

NOTE
Certain other operations, especially those relating to signal clocks, will 
be disabled until the synchronization pulse is received. In the event of 
the pulse not being received, the :ODI:TOSync:CANCel command may be 
used to cancel the pending synchronization operation.

NOTE
Timestamp output and synchronization is only supported when DDC is 
active. Any change to sample mode or DDC decimation rate will reset the 
synchronization to local system time.
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:ODI:TOSync:CANCel

Command :ODI:TOSync:CANCel
Description Cancel a pending ODI time synchronization. In the event of failure to emit 

the synchronization pulse, this command may be necessary to restore 
access to other commands.

Example :ODI:TOSync:CANCel

:ODI:TOSync:SOURce 

Command :ODI:TOSync:SOURce <source>
Query :ODI:TOSync:SOURce?

Description Specify the signal source used to synchronize the time output in ODI 
timestamps. When the :ODI:TOSync command is active and a pulse is 
received on the specified input.

<source> The synchronization source, may be either TRIG or SYNC.

Example :ODI:TOSync:SOURce TRIG

:ODI:TOSync:PORT<N>:ADJust <picoseconds>

Command :ODI:TOSync:PORT<N>:ADJust <picoseconds>
Parameter An integer time adjustment in picoseconds, positive or negative.

Description The command allows the timestamp counter for an individual channel to 
be adjusted, to allow compensation for cable length for example. 
Adjustments are cumulative

Example :ODI:TOSync:PORT<N>:ADJust 10000

NOTE
Sync input maximum safe voltage is 1V. If Sync input is connected with a 
trigger output from M9506A, the output must be configured as 50 Ohm 
Push/Pull. An external 6db attenuator must be connected to the "Sync 
In" port connector to avoid damage to input circuitry.
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Trigger Commands

The digitizer trigger circuitry helps you locate the waveform you want to 
view. The type of triggering used is edge triggering. Edge triggering 
identifies a trigger condition by looking for the slope (rising or falling) and 
voltage or power level (trigger level) on the source you select. Any of the 
four input channels and the external trigger input can be used as the 
trigger source. Additionally, the Sync Input can be used as a trigger 
source, when two or more digitizers are operating as a synchronous 
system. The commands in this subsystem define the conditions for 
triggering.

Trigger arming behavior

After the :DIGitize command is received, the trigger system tries to arm the 
trigger. When at least one complete vector, where all samples don’t fulfill 
the trigger condition is received, the trigger system goes to armed state. In 
the worst case (the first sample not fulfilling the trigger condition is the 
second sample of a vector), this means that twice the vector size minus 
one sample not fulfilling the trigger condition must be received. When the 
trigger system is in the armed state, the next sample, that fulfills the 
trigger condition causes a trigger event.

In Data Processing Mode DIRect the vector size refers to the samples 
received from the ADC without further processing. In Data Processing 
Mode DDC the vector size refers to the samples after decimation and DDC 
processing.

Pre-trigger-time

Sample rate 16GSa/s, Data Processing Mode DIRect

A vector consists of 40 samples. The pre-trigger-time is 20ns for all 
decimation values.

Decimation Sample Time
(ns)

Vector Time
(ns)

Vectors Before
Trigger

Pre-Trigger Time
(ns)

1 0.0625 2.5 8 20

2 0.125 5 4 20

4 0.25 10 2 20
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Sample rate 32GSa/s, Data Processing Mode DIRect

A vector consists of 80 samples. The pre-trigger-time is 20ns for all 
decimation values.

Sample rate 16GSa/s, Data Processing Mode DDC

A vector consists of 16 I/Q sample pairs. The number of pre-trigger 
samples is the equivalent of 32 vectors. The following table lists the 
resulting pre-trigger-time dependent on the decimation value.

Decimation Sample Time (ns) Vector Time (ns) Vectors Before
Trigger

Pre-Trigger Time
(ns)

1 0.03125 2.5 8 20

2 0.0625 5 4 20

4 0.125 10 2 20

Decimation Sample Time (ns) Vector Time (ns) Vectors Before
Trigger

Pre-Trigger
Time (ns)

4 0.25 4 32 128

8 0.5 8 32 256

16 1 16 32 512

32 2 32 32 1024

64 4 64 32 2048

128 8 128 32 4096

256 16 256 32 8192

512 32 512 32 16384
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Sample rate 32GSa/s, Data Processing Mode DDC

A vector consists of 32 I/Q sample pairs. The number of pre-trigger 
samples is the equivalent of 32 vectors. The following table lists the 
resulting pre-trigger-time dependent on the decimation value.

: TRIGger:SWEep

Command :TRIGger:SWEep {AUTO | TRIGgered}
Description The command selects the sweep mode, which defines how the capture of 

digitized samples to memory or the ODI streaming is started.

AUTO Capture to memory or ODI streaming will start on trigger reception. 
If a trigger event does not occur within 20 ms, the digitizer automatically 
forces a trigger. If the frequency of your waveform is 50 Hz or less, you 
should not use the AUTO sweep mode, because it is possible that the 
digitizer will automatically trigger before your waveform trigger occurs.

TRIGgered Capture to memory or ODI streaming will start on trigger 
reception. If no trigger occurs, capture to memory or ODI streaming will 
not start.

Query :TRIGger:SWEep?

The query returns the current setting for the sweep mode.

Returned Format [:TRIGger:SWEep] {AUTO | TRIGgered}<NL>

Decimation Sample Time (ns) Vector Time (ns) Vectors Before
Trigger

Pre-Trigger Time
(ns)

4 0.125 4 32 128

8 0.25 8 32 256

16 0.5 16 32 512

32 1 32 32 1024

64 2 64 32 2048

128 4 128 32 4096

256 8 256 32 8192

512 16 512 32 16384
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: TRIGger:EDGE:SOURce

Command :TRIGger:EDGE:SOURce {EXTernal | CHANnel<N> | 
SYNCinput}

Description The command selects the source for trigger events.

<N> An integer, 1-4.

EXTernal Use the external trigger input.

CHANnel<N> Use an analog input channel.

SYNCinput Use the Sync Input. This trigger source must be selected in the 
secondary module digitizer, when multiple digitizers are connected to 
allow synchronous capture to memory or synchronous ODI streaming. The 
Sync Output of the primary digitizer must be connected to the Sync Input 
of the secondary digitizers.

Query :TRIGger:EDGE:SOURce?

The query returns the current setting for the trigger source.

Returned Format [:TRIGger:EDGE:SOURce] {EXTernal | CHANnel<N> | SYNCinput}<NL>

: TRIGger:EDGE:SLOPe

Command :TRIGger:EDGE:SLOPe {POSitive | NEGative}
Description The command sets the slope of the trigger source. The slope setting is 

always the same for all trigger sources.

POSitive Trigger on a rising edge.

NEGative Trigger on a falling edge.

Query :TRIGger:EDGE:SLOPe?

The query returns the current setting for the trigger slope.

Returned Format [:TRIGger:EDGE:SLOPe] {POSitive | NEGative<N>}<NL>
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:TRIGger:LEVel:EXTernal

Command :TRIGger:LEVel:EXTernal <level>
Description The command specifies the trigger level when the external trigger input is 

used as trigger source.

<level> The trigger level in volts as a floating-point number.

Query :TRIGger:LEVel:EXTernal?

The query returns the current trigger level.

Returned Format [:TRIGger:LEVel:EXTernal] <level><NL>

:TRIGger:LEVel[:CHANnel]

Command :TRIGger:LEVel[:CHANnel] CHANnel<N>, <level>
Description The command specifies the trigger level when an analog input channel is 

used as trigger source.

<N> An integer, 1-4.

<level> The trigger level in volts as a floating point number.

Query :TRIGger:LEVel[:CHANnel]? CHANnel<N> 

The query returns the current trigger level.

Returned Format [:TRIGger:LEVel[:CHANnel]] <level><NL>

:TRIGger:LEVel:IFMagnitude

Command :TRIGger:LEVel:IFMagnitude CHANnel<N>, <level>
Description The command specifies the Intermediate Frequency Magnitude trigger 

level when an analog input channel is used as trigger source and the data 
processing mode is DDC.

A trigger event is generated, when the power PSample,dBm of an IQ sample 
pair after DDC processing and decimation is above the specified trigger 
level in dBm according to the following formula:

PSample = (i2 + q2)  * yInc2 / 50 Ω

PSample,dBm = 10 * log10(PSample / 1 mW)
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yInc is the scaling factor to compute the voltage value from an ADC 
sample, see :WAVeform:YINCrement? on page 162.

This measure refers to the calculation of the power spectral density of the 
intermediate frequency passband signal and depicts the power level of a 
given complex signal within the DDC analysis bandwidth.

<N> An integer, 1-4.

<level> The trigger level in dBm as a floating-point number.

Query :TRIGger:LEVel:IFMagnitude? 

CHANnel<N> The query returns the current trigger level.

Returned Format [:TRIGger:LEVel:IFMagnitude] <level><NL>

:TRIGger:HOLDoff

Command :TRIGger:HOLDoff <holdoff_time>
Description The command specifies the amount of time the digitizer should wait after 

receiving a trigger before enabling the trigger again. This is the behavior 
for the holdoff type NORMal. The behavior of the trigger holdoff time can 
be further modified by setting the holdoff type to ABOVe and BELow using 
the :TRIGger:HOLDoff:TYPE command. 

<holdoff_time> The holdoff time in seconds as a floating-point number. It 
is the same for all trigger sources.

Query :TRIGger:HOLDoff?

The query returns the current holdoff time.

Returned Format [:TRIGger:HOLDoff] <holdoff_time><NL>

: TRIGger:HOLDoff:TYPE

Command :TRIGger:HOLDoff:TYPE {NORMal | ABOVe | BELow}
Description The command selects the trigger holdoff type. This setting defines how the 

holdoff time is used. It is the same for all trigger sources.

NORMal The trigger event is generated, when the holdoff time has elapsed 
after the last trigger event and the signal characteristic of interest crosses 
the threshold with the slope defined in the :TRIGger:EDGE:SLOPe 
command.
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ABOVe This setting is only defined for negative slope and triggered sweep 
mode (TRIGger:SWEep TRIGgered). The trigger event is generated, if the 
signal characteristic of interest crosses the threshold (with negative slope) 
after having been above the threshold for at least the holdoff time. The 
trigger event is associated with the time the level was crossed.

BELow This setting is only defined for positive slope and triggered sweep 
mode (TRIGger:SWEep TRIGgered). The trigger event is generated, if the 
signal characteristic of interest crosses the trigger threshold (with positive 
slope) after having been below the threshold for at least the holdoff time. 
The trigger event is associated with the time the level was crossed.

Query :TRIGger:HOLDoff:TYPE?

The query returns the current setting for the holdoff type.

Returned Format [:TRIGger:HOLDoff:TYPE] { NORMal | ABOVe | BELow }<NL>

:TRIGger: SYNCout[?]

Command :TRIGger:SYNCout {0 | OFF | 1 | ON}
Description This command is used to support the synchronous start of the capture 

operation on multiple digitizers. It enables or disables the output of trigger 
pulses on the Sync Output. For synchronous operation the Sync Output of 
the primary digitizer must be connected to the Sync Input of the secondary 
digitizer. The capture is started by a received trigger event on the primary 
digitizer, which is distributed to all connected secondary digitizers.

0 | OFF No trigger pulses are output on Sync Output.

1 | ON Trigger pulses are output on Sync Output.

Query :TRIGger:SYNCout?

The query returns, if output of trigger pulses on the Sync Output is enabled 
or disabled.

:TRIGger:MODE[?]

Command :TRIGger:MODE {EDGE}
Description The command sets the trigger mode. Currently, “Edge” is the only 

supported mode.

Query :TRIGger:MODE?

The query returns the trigger mode.
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:TRIGger:OUTPut:MODE

Command :TRIGger:OUTPut:MODE {A|B}, 
{LOW|HIGH|TOGGle|FSM|BYPass}

Description The command selects the trigger output mode for the selected FPGA.

Based on the selected Mode, the  :TRIGger:OUTPut:SOURce provides the 
following outcomes on the trigger output.

The mode determines, which data the FPGA sends to the trigger output. 
The :TRIGger:OUTPut:SOURce command finally determines, which FPGA’s 
data is displayed at the trigger output.

A Selects FPGA A.

B Selects FPGA B.

LOW Constant low-level

HIGH Constant high-level

TOGGle Low-level/high-level toggle pattern. 200 MHz square wave with 
50% duty cycle.

Inside the FPGA is a trigger logic that consists of a 40-bit comparator and 
an FSM. To generate a trigger, the data (40 10-bit ADC Samples) flows to 
the comparator and enters the FSM. This last one will make sure a trigger 
is generated in case the outcome of at least one of the 40 evaluated 
samples is asserted. The evaluation requires parameters: Edge and 
Threshold, both can be manually adjusted by the user. Based on the type 
of edge (Positive or Negative) and the threshold value, the comparator's 
outcome will be determined and forwarded to the FSM. At this point, there 
is a distinction in the description between the FSM Mode and the BYPass 
Mode.

FSM

In case of an assertion provided by the comparator, the FSM will generate 
a trigger with a pulse equal to 100 ns. This pulse will be shown at the 
trigger output transceiver.

BYPass

The outcome of the 40-bit comparator will be shown at the trigger output 
transceiver bypassing the FSM. 

This mode is used by the deterministic latency setup procedure.
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Query :TRIGger:OUTPut:MODE? {A|B}

The query returns the current trigger output mode. 

Returned Format [:TRIGger:OUTPut:MODE {A|B}] { LOW|HIGH |TOGGle|FSM|BYPass }<NL>

:TRIGger:OUTPut:SOURce

Command :TRIGger:OUTPut:SOURce {A|B}
Description The command selects, which FPGA’s data is displayed at the trigger 

output.

A Selects FPGA A.

B Selects FPGA B.

Query :TRIGger:OUTPut:SOURce?

The query returns the current trigger output source.

Returned Format [:TRIGger:OUTPut:SOURce] {A|B }<NL>
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:TEST:PON?

Query :TEST:PON?
Parameters None

Description This query returns the result of the power on self-tests.

Example Query

:TEST:PON?

:TEST:TST?

Query :TEST:TST?
Parameters None

Description This query is similar to *TST? but the actual test messages are returned.

Example Query

:TEST:TST?
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Introduction

In a standard installation, the examples can be found in the folder “C:\
Program Files (x86)\Keysight\M8131\Examples”. They are all console 
applications and are provided as Microsoft Visual Studio 2019 solutions. 
Except for the <C++ Demo Connection Setup>, the programs are written in 
C# and use the VISA.NET library. The <C++ Demo Connection Setup> is 
written in C++ and uses the <library>.
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Capture

This example program (Capture.sln) demonstrates how to set up the 
M8131A digitizer for capturing a test signal. 

In the example, channel 1 of the digitizer is used. Data acquisition is done 
in direct mode with decimation factor 4. The program works with 16GSa/s 
and 32GSa/s ADC sample rate. The sample rate must be set before 
starting the program. 

Cabling of Digitizer Connectors 

• Analog input channel 1 - receives the test signal to be digitized 

Setup Digitizer

Before starting the example program, start the M8131A and prepare the 
signal source to capture. If needed, change the sample rate in the 
M8131A.

Run Capture

The program uses "TCPIP0::localhost::hislip0::INSTR" to access the 
M8131A, and it assumes that an analog signal is connected to channel 1. 
It can be started with command line parameters to use other VISA 
resource strings for M8131A and another input channel. 

Command line: Capture digitizer-resource channel

Example call: Capture "TCPIP0::localhost::hislip2::INSTR" 2

In each step after each SCPI command is sent to the digitizer, the 
execution status is read, and errors displayed.

1 Set the digitizer to Direct mode. 

2 Set the trigger level on the input channel. 

3 Set trigger source to the input channel. 

4 Set sweep mode to Triggered. 

5 Set the number of samples to capture. 

6 Set up capture on the digitizer. 

7 Set the decimation factor. 

8 Start capturing data. 

9 Wait until the acquisition is completed. 

10 Set binary data upload format to big-endian. 
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11 Read captured data as a binary block. Finally, the example prints the 
first captured data to the console.

Synchronization of Two M8131A Modules

This example program (SynchronizeTwoM8131.sln) demonstrates how to 
synchronize two M8131A digitizer modules and then capture a test signal 
with both digitizers.

The synchronization is achieved with locked reference clock signals - 
primary module Ref Clk Out to secondary module Ref Clk In - and clock 
alignment signals – primary module Snyc Out to secondary module Snyc 
In.

In the example, channel 1 on both digitizers is used. Data acquisition is 
done in direct mode with decimation factor 4. The program works with 
16GSa/s and 32GSa/s ADC sample rate. The sample rate must be set 
before starting the program.

Cabling of first (primary) Digitizer Connectors 

• Analog input channel 1 - receives the test signal to be digitized.

• Sync Out to secondary digitizer Sync In - transmits a clock signal to 
the Sync In of the secondary digitizer for core clock alignment.

• Ref Clk Out to secondary digitizer Ref Clk In - provides the reference 
clock for the secondary digitizer.

Cabling of the second (secondary) Digitizer Connectors 

• Analog input channel 1 - receives the test signal to be digitized.

• Sync In to primary digitizer Sync Out - receives the clock signal from 
the primary digitizer for core clock alignment.

• Ref Clk In to primary digitizer Ref Clk Out - receives the reference clock 
from the primary digitizer.

Setup Digitizers

Before starting the example program, start both M8131A and prepare the 
signal sources to capture. If needed, change the sample rates in the 
M8131A. 
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Run SynchronizeTwoM8131

The program uses "TCPIP0::localhost::hislip1::INSTR" to access the 
primary M8131A and "TCPIP0::localhost::hislip2::INSTR" to access the 
secondary M8131A. It assumes that analog signals are connected to 
channel 1 of both digitizers. It can be started with command line 
parameters to use other VISA resource strings for both M8131A. 

Command line: Capture primary-resource secondary-resource

Example call: Capture "TCPIP0::localhost::hislip3::INSTR" 
"TCPIP0::localhost::hislip4::INSTR" 

The program is divided into a part that synchronizes the M8131A and a 
part that captures data.

In each step after each SCPI command is sent to the digitizer, the 
execution status is read, and errors displayed.

Synchronize M8131A

1 Disable trigger output on Sync Out on both M8131A.

2 Set secondary module to use external 100 MHz reference clock from 
the primary module.

3 Set the secondary module sync input threshold to 410 mV.

4 Set an LCM period on both M8131A.

5 Set primary module to generate clock signal on Sync Out.

6 Align secondary module clock signal to sync signal received on Sync 
In.

7 Set primary module to stop clock signal on Sync Out.

8 Enable trigger output on Sync Out on both M8131A.

Capture signals

9 Set both M8131A to Direct mode.

10 Set the trigger level on the input channel on both M8131A. 

11 Set primary module trigger source to input channel. 

12 Set secondary module trigger source to Sync In.

13 Set sweep mode to Triggered on both M8131A. 

14 Set the number of samples to capture on both M8131A. 

15 Prepare capture on both M8131A. 

16 Set the decimation factor on both M8131A. 

17 Start capturing data on the secondary module. 

18 Wait until arming on secondary module is completed. 

19 Start capturing data on the primary module.
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20 Wait until acquisition on primary module is completed. 

21 Wait until acquisition on secondary module is completed. 

22 Set binary data upload format to big-endian on both M8131A. 

23 Read captured data as a binary block from both M8131A. Finally, the 
example prints the first captured data from both digitizers to the 
console.
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Continuous Streaming with Deterministic Latency to DSP Module

This example program (M8131AToM8132ALatency.sln) demonstrates how 
to set up the M8131A digitizer and the M8132A DSP for Deterministic 
Latency Mode and stream digitized data from the M8131A digitizer to the 
M8132A DSP.

In the example, channel 1 of the digitizer is used. The program works with 
16GSa/s and 32GSa/s ADC sample rate. For 32GSa/s an additional ODI 
connection between M8131A and M8132A is needed. The sample rate 
must be set before starting the program.

Cabling of Digitizer Connectors

• Analog input channel 1 - receives the test signal to be digitized and 
streamed to the DSP

• Trigger output - outputs high-level, when the digitized sample is 
positive, else low-level

• ODI1 to DSP ODI2 - streams digitized samples to the DSP (16GSa/s 
and 32GSa/s mode)

• ODI3 to DSP ODI4 - streams digitized samples to the DSP (32GSa/s 
mode)

• SyncOut to DSP SyncIn - transmits a clock signal to the SyncIn of the 
DSP for core clock alignment

• RefClkOut to DSP RefClkIn - provides the reference clock for the DSP

Cabling of DSP Connectors

• Trigger output - outputs high-level, when the sample received on ODI2 
is positive, else low-level

• ODI2 to digitizer ODI1 - receives the samples from ODI1 of the digitizer 
(16GSa/s and 32GSa/s mode)

• ODI4 to digitizer ODI3 - receives the samples from ODI2 of the digitizer 
(32GSa/s mode)

• SyncIn to digitizer SyncOut - receives the clock signal from the 
digitizer for core clock alignment

• RefClkIn to digitizer RefClkOut - receives the reference clock from the 
digitizer
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Setup Digitzer and DSP

Before starting the example program, start the M8131A and the M8132A. 
If needed, change the sample rate in the M8131A.

Run M8131AToM8132ALatency

The program uses "TCPIP0::localhost::hislip0::INSTR" to access the 
M8131A and "TCPIP0::localhost::hislip1::INSTR" to access the M8132A. It 
can be started with command line parameters to use other VISA resource 
strings for M8131A and M8132A.

Command line: M8131AToM8132ALatency dig-resource dsp-resource

Example call: M8131AToM8132ALatency 
"TCPIP0::localhost::hislip2::INSTR" "TCPIP0::localhost::hislip3::INSTR"

In each step after each SCPI command to the digitizer and the DSP the 
execution status is read, and errors displayed.

1 Set digitizer trigger source to channel 1. Without this setting, FPGA B 
would not forward data to the trigger output.

2 Set DSP to use a 100MHz external reference clock provided by the 
digitizer.

3 Set digitizer and DSP LCM period.

4 Set the latency calibration mode. For M8131A to M8132A, you need 
separate steps for phase alignment and latency calibration.

5 Generate a sync signal on Sync Out of digitizer.

6 Align the core clock of the DSP to the sync signal received on Sync In.

7 Stop the sync signal.

8 Switch on ODI1 and ODI3 (32G mode only) on digitizer and ODI2 and 
ODI4 (32G mode only) on DSP. Wait for all ODI ports to come up.

9 Arm the latency adjustment on DSP.

10 Prepare the start of the latency measurement on digitizer.

11 Prepare ODI1 and ODI3 (32G mode only) data streaming on the 
digitizer.

12 Set up the multiplexers in FPGA A of the DSP to receive data from ODI2 
and ODI4 (32G mode only).

13 Set up the trigger output of digitizer and DSP to display the polarity of 
the received signal. A positive ADC sample generates a logical "1", a 
negative ADC sample a logical "0".

14 Set the synchronization pulse delay for FPGA A and B on the digitizer 
and the DSP.
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15 Start ODI data streaming. Digitized data is streamed from the digitizer 
to DSP with deterministic latency until ODI data streaming is stopped 
in the next step. It is recommended to use a low-frequency square 
signal (below 500kHz) as input for digitizer channel 1. Then the 
established latency can be verified by measuring the time between the 
rising edges of the signals output on digitizer and DSP trigger output.

16 Stop ODI data streaming.

17 Switch off ODI1 and ODI3 (32G mode only) on digitizer and ODI2 and 
ODI4 (32G mode only) on DSP.
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Performance Specification

The performance specification can be found in the Data Sheet of the 
M8131A at: http://www.keysight.com/find/M8131A.

Operating Environment

Storage Temperature −40 °C to +70 °C

Operating Temperature 0 °C to 40 °C

Operating Humidity 5% to 80% relative humidity, non-condensing

Operating Altitude Up to 2000 m

Installation Category II

Pollution Degree 2
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WARNING
The instrument is not designed for outdoor use. Do not expose the 
instrument to rain or other excessive moisture. Protect the instrument 
from humidity and temperature changes, which could cause 
condensation within the instrument.

Do not operate the instrument in the presence of flammable gases, 
fumes or powders. Operation of any electrical instrument in such an 
environment constitutes a definite safety hazard.

Power consumption 350 W (nom)

Safety tested according to IEC61010-1, ANSI/UL61010, CSA22.2 No. 61010-1 certified

EMC tested according to IEC61326

Warm-up time 15 min

Calibration interval 1 year recommended

Cooling 
Requirements

When operating the M8131A choose a location that provides at least 80 mm of clearance at rear, and at 
least 30 mm of clearance at each side for the AXIe chassis.
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